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Product comparison

  M570dn

CZ271A

M570dw

CZ272A

Paper handling Tray 1 (100-sheet capacity)

Tray 2 (250-sheet capacity)

Optional Tray 3 (500-sheet
capacity)

Standard output bin (250-sheet
capacity)

Automatic duplex printing

Supported operating
systems

Windows XP, 32-bit

 Windows Vista, 32-bit and 64-
bit

 Windows 7, 32-bit and 64-bit

 Windows 2003 Server (32-bit,
Service Pack 3), print and scan
drivers only

 Windows 2008 Server, print
and scan drivers only

Windows 2008 Server R2, print
and scan drivers only

 Mac OS X v10.6 and later

Connectivity Hi-Speed USB 2.0

10/100/1000 Ethernet LAN
connection

Wireless network connection  

Memory 256 MB RAM

Control-panel display Color graphical touch screen

Print Prints 30 pages per minute (ppm)
on A4-size paper and 31 ppm
on Letter-size paper

Walk-up USB printing (no
computer required
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  M570dn

CZ271A

M570dw

CZ272A

Copy Copies at up to 20 ppm

Copy resolution is 300 dots per
inch (dpi)

This document feeder holds up to
50 pages and supports page
sizes from 127 to 356 mm (5 to
14 in) in length and from 127 to
216 mm (5 to 8.5 in) in width

Flatbed scanner supports page
sizes up to 297 mm (11.7 in) in
length and up to 215 mm (8.5
in) in width

Automatic duplex copying

Scan Scans in black and white with
resolution up to 1200 dpi from
the flatbed glass

Scans in color with resolution up
to 300 dpi from the document
feeder and up to 600 dpi from
the flatbed glass

Automatic duplex scanning

Scan to Email (no software
required)

Scan to Network Folder (no
software required)

Walk-up USB scanning (no
computer required)

Fax V.34 with two RJ-11 fax ports
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Product views
● Product front view

● Product back view

● Interface ports

● Serial number and model number location

Product front view

1 2
3

4

5

6

7

8

12

13

14

9

11

10

1 Latch to release the document-feeder cover (access for clearing jams)

2 Document-feeder input tray

3 Document-feeder output bin

4 Control panel with color touchscreen display (tilts up for easier viewing)

5 Walk-up USB port (for printing and scanning without a computer)

6 Handle for the right door (access for clearing jams)

7 Tray 1

8 On/off button

9 Jam-access door for optional Tray 3

10 Optional Tray 3
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11 Tray 2

12 Front door (access to the toner cartridges and the toner-collection unit)

13 Output bin

14 Scanner handle (to raise the scanner lid)

Product back view

1

3 2

1 Formatter (contains the interface ports)

2 Power connection

3 Slot for a cable-type security lock
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Interface ports

1

3

2

4

1 Local area network (LAN) Ethernet (RJ-45) network port

2 Hi-Speed USB 2.0 printing port

3 Telephone “line out” port for attaching an extension phone, answering machine, or other device

4 Fax “line in” port for attaching the fax phone line to the product
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Serial number and model number location

The model number and serial number are listed on an identification label located on the back of the
product. They are also listed on the inside of the front door. The serial number contains information
about the country/region of origin, the product version, production code, and the production number of
the product.

Model name Model number

M570dn CZ271A

M570dw CZ272A
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Control panel
● Control-panel layout

● Control-panel Home screen

● Control-panel help system

Control-panel layout

1 Wireless light (wireless models
only)

Indicates the wireless network is enabled. The light blinks while the product is establishing a
connection to the wireless network.

2 Touchscreen display Provides access to the product features and indicates the current status of the product

3 Attention light Indicates a problem with the product

4 Ready light Indicates the product is ready

5 Help button and light Provides access to the control-panel help system

6 Right arrow button and light Moves the cursor to the right or moves the display image to the next screen

NOTE: This button illuminates only when the current screen can use this feature.

7 Cancel button and light Clears settings, cancels the current job, or exits the current screen

NOTE: This button illuminates only when the current screen can use this feature.

8 Back button and light Returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.
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9 Left arrow button and light Moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.

10 Home button and light Provides access to the Home screen

Control-panel Home screen

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

1 Web Services  button Provides quick access to HP Web Services features, including HP ePrint

HP ePrint is a tool that prints documents by using any email enabled device to send
them to the product’s email address.

2 Setup  button Provides access to the main menus

3 Wireless  button (wireless
models only)

Provides access to the Wireless menu and wireless status information

NOTE: When you are connected to a wireless network, this icon changes to a set of
signal strength bars.

NOTE: This button does not display when the product is connected to a wired
network.

4 Network  button Provides access to network settings and information. From the network settings screen,
you can print the Network Summary page.

NOTE: This button displays only when the product is connected to a network.

5 Information  button Provides product status information. From the status summary screen, you can print the
Configuration Report page.

6 Supplies  button Provides information about supplies status. From the supplies summary screen, you can
print the Supplies Status page.

7 Fax button Provides access to the Fax feature
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8 Apps button Provides access to the Apps menu to print directly from Web applications that you have
downloaded from the HP ePrintCenter Web site at www.hpeprintcenter.com

9 Product status Indicates whether the product is ready or is processing a job

10 Scan button Provides access to the scan features

11 Copy button Provides access to the copy features

12 USB button Provides access to the walkup-USB feature (for printing and scanning without a
computer)

Control-panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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Print product reports
From the Reports menu, you can print several informative pages about the product.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

Menu item Description

Demo Page Prints a page that demonstrates print quality

Menu Structure Prints a map of the control panel-menu layout. The active settings for each menu are
listed.

Configuration Report Prints a list of all the product settings. Includes basic network information when the
product is connected to a network.

Supplies Status Prints the status for each toner cartridge, including the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Network Summary Prints a list of all product network settings

Usage Page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, monochrome (black and white) or color pages; and
reports the page count

PCL Font List Prints a list of all the PCL fonts that are installed

PS Font List Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List Prints a list of all the PCL6 fonts that are installed

Color Usage Log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service Page Prints the service report

Diagnostics Page Prints the calibration and color diagnostics pages

Print Quality Page Prints a page that helps solve problems with print quality
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2 Paper trays

● Supported paper sizes

● Supported paper types

● Tray 1

● Tray 2

● Optional Tray 3
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Supported paper sizes
NOTE: To obtain the best results, select the correct paper size and type in the print driver before
printing.

Table 2-1  Supported paper sizes

Size and dimensions Tray 1 Tray 2 Tray 3
(optional)

Automatic
duplex printing

Letter

216 x 279 mm (8.5 x 11 in)

Legal

216 x 356 mm (8.5 x 14 in)

 

A4

210 x 297 mm (8.3 x 11.7 in)

RA4

215 x 305 mm (8.5 x 12.0 in)

 

A5

148 x 210 mm (5.8 x 8.3 in)

B5 (JIS)

182 x 257 mm (7.2 x 10.1 in)

B6 (JIS)

128 x 182 mm (5.0 x 7.2 in)

   

Executive

184 x 267 mm (7.25 x 10.5 in)

Statement

140 x 216 mm (5.5 x 8.5 in)

   

4x6

102 x 152 mm (4 x 6 in)

   

10 x 15 cm

102 x 152 mm (4 x 6 in)

   

3x5

76 x 127 mm (3 x 5 in)

   

5x7

127 x 178 mm (5 x 7 in)
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Table 2-1  Supported paper sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3
(optional)

Automatic
duplex printing

5x8

127 x 203 mm (5 x 8 in)

   

A6

105 x 148 mm (4.1 x 5.8 in)

   

Postcard (JIS)

100 x 148 mm (3.9 x 5.8 in)

   

D Postcard (JIS)

200 x 148 mm (7.9 x 5.8 in)

   

16K

184 x 260 mm (7.2 x 10.25 in)

16K

195 x 270 mm (7.7 x 10.6 in)

16K

197 x 273 mm (7.75 x 10.75 in)

8.5 x 13

216 x 330 mm (8.5 x 13 in)

 

Envelope #10

105 x 241 mm (4.1 x 9.5 in)

   

Envelope B5

176 x 250 mm (6.9 x 9.8 in)

   

Envelope C5

162 x 229 mm (6.4 x 9 in)

   

Envelope DL

110 x 220 mm (4.3 x 8.7 in)

   

Envelope Monarch

98 x 191 mm (3.9 x 7.5 in)

   

Custom

76 x 127 mm to 216 x 356 mm (3.0 x 5.0 in to
8.5 x 14 in)
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Table 2-1  Supported paper sizes (continued)

Size and dimensions Tray 1 Tray 2 Tray 3
(optional)

Automatic
duplex printing

Custom

148 x 210 mm to 216 x 297 mm (5.8 x 8.3 in to
8.5 x 11.7 in)

   

Custom

148 x 210 mm to 216 x 356 mm (5.8 x 8.3 in to
8.5 x 14 in)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
lj500colorMFPM570.

NOTE: To obtain the best results, select the correct paper size and type in the print driver before
printing.

Paper type Tray 1 Tray 21 Tray 3 (optional) Automatic duplex
printing

Plain

Light 60–74g

Midweight 96–110g

Heavy 111–130g

Extra Heavy 131–175g  

Extra Heavy 131–163g    

Color Transparency  

Labels   

Letterhead

Preprinted

Prepunched

Colored

Rough

Bond

Recycled

Envelope    

Cardstock 176–220g    

Mid-weight glossy 105–110g  

Heavy glossy 111–130g

Extra-heavy glossy 131–175g

Card glossy 176–220g

Opaque film

HP EcoSMART Lite

HP Tough Paper

HP Matte 105g

HP Matte 120g

ENWW Supported paper types 17

http://www.hp.com/support/lj500colorMFPM570
http://www.hp.com/support/lj500colorMFPM570


Paper type Tray 1 Tray 21 Tray 3 (optional) Automatic duplex
printing

HP Matte 160g

HP Matte 200g    

HP Soft Gloss 120g

HP Glossy 130g

HP Glossy 160g

HP Glossy 220g

1 The stack height for Tray 2 is 100 sheets for glossy paper and 20 mm (.79 in) for short paper (A5, A6, 4x6, and landscape).

18 Chapter 2   Paper trays ENWW



Tray 1
● Tray capacity and paper orientation

● Load Tray 1

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 2-2  Tray 1 capacity

Paper type Specifications Quantity

Paper Range:

60 g/m2 (16 lb) to 220 g/m2 (58 lb)

Maximum stack height: 10 mm (0.39 in)

Equivalent to 100 sheets of 75 g/m2 (20 lb)

Envelopes Less than 60 g/m2 (16 lb) to 90 g/m2 (24 lb) Up to 10 envelopes

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm (0.39 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 10 mm (0.39 in)

Up to 50 sheets

Glossy paper Range:

105 g/m2 (28 lb) to 220 g/m2 (58 lb)

Maximum stack height: 10 mm (0.39 in)

Up to 50 sheets

Table 2-3  Tray 1 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-down

Top edge leading into the product
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Table 2-3  Tray 1 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  2-sided printing Face-up

Bottom edge leading into the product

 Landscape 1-sided printing Face-up

Top edge toward the front of the product

  2-sided printing Face-up

Top edge toward the front of the product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the product

20 Chapter 2   Paper trays ENWW



Table 2-3  Tray 1 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

Envelopes Long edge of the envelope
feeding into the product

1-sided printing Face-down

Top edge leading into the product

 Short edge of the envelope
feeding into the product

1-sided printing Face-down

Top edge toward the back of the product

Load Tray 1

1. Open Tray 1.  
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2. Slide out the tray extension.  

3. Fold out the tray extension to support the
paper and open the side guides.

 

4. Load paper in the tray face-down and the
short, top edge going into the product first.
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5. Make sure the stack fits under the tabs on the
guides and does not exceed the tray-full
indicators.

 

6. Adjust the side guides so that they lightly touch
the paper stack but do not bend it.

 

ENWW Tray 1 23



Print envelopes

If your software does not automatically format an envelope, specify Landscape for page orientation in
your software program or print driver. Use the following guidelines to set margins for return and
destination addresses on Commercial #10 or DL envelopes:

Address type Left margin Top margin

Return 15 mm (0.6 in) 15 mm (0.6 in)

Destination 102 mm (4 in) 51 mm (2 in)

For envelopes of other sizes, adjust the margin settings accordingly.
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Tray 2
● Tray capacity and paper orientation

● Load Tray 2

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 2-4  Tray 2 capacity

Paper type Specifications Quantity

Paper Range:

60 g/m2 (16 lb) to 220 g/m2 (58 lb)

Equivalent to 250 sheets of 75 g/m2 (20 lb)

Maximum stack height: 25 mm (.98 in)

For A5, A6, and 4x6 paper sizes, and for paper
printed in a landscape orientation the maximum stack
height is 15 mm (.59 in),

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 25 mm (.98 in)

Glossy paper Range:

105 g/m2 (28 lb) to 220 g/m2 (58 lb)

100 sheets

Table 2-5  Tray 2 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-up

Top edge at the right side of the tray
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Table 2-5  Tray 2 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

  2-sided printing Face-down

Top edge at the left side of the tray

 Landscape 1-sided printing Face-up

Top edge toward the back of the product

  2-sided printing Face-down

Top edge toward the front of the product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the product

Load Tray 2

This tray holds up to 250 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not
hold as many sheets. Do not overfill the tray.

CAUTION: Do not print envelopes, labels, postcards, or unsupported sizes of paper from Tray 2.
Print these types of paper only from Tray 1.

26 Chapter 2   Paper trays ENWW



1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latch and
sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face-up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might display during printing
or the paper might jam.

 

4. Slide the tray into the product.  
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Optional Tray 3
● Tray capacity and paper orientation

● Load Tray 3

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 2-6  Tray 3 capacity

Paper type Specifications Quantity

Paper Range:

60 g/m2 (16 lb) to 220 g/m2 (58 lb)

Equivalent to 500 sheets of 75 g/m2 (20 lb)

Maximum stack height: 56 mm (2.2 in)

Labels Maximum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Transparencies Minimum: 0.102 mm (0.004 in) thick Maximum stack height: 56 mm (2.2 in)

Glossy paper Range:

105 g/m2 (28 lb) to 220 g/m2 (58 lb)

Maximum stack height: 56 mm (2.2 in)

Table 2-7  Tray 3 paper orientation

Paper type Image orientation Duplex mode How to load paper

Preprinted or letterhead Portrait 1-sided printing Face-up

Top edge at the right side of the tray

  2-sided printing Face-down

Top edge at the left side of the tray
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Table 2-7  Tray 3 paper orientation (continued)

Paper type Image orientation Duplex mode How to load paper

 Landscape 1-sided printing Face-up

Top edge toward the back of the product

  2-sided printing Face-down

Top edge toward the front of the product

Prepunched Portrait or landscape 1- or 2-sided printing Holes toward the back of the product

Load Tray 3

This tray holds up to 500 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not
hold as many sheets. Do not overfill the tray.

CAUTION: Do not print envelopes, postcards, or unsupported sizes of paper from Tray 3. Print these
types of paper only from Tray 1.
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1. Slide open the tray.

NOTE: Do not open the tray while it is in
use.

 

2. Adjust the paper-length and paper-width
guides by squeezing the adjustment latches
and sliding the guides to the size of the paper
being used.

 

3. Load paper into the tray face-up. Check the
paper to verify the guides lightly touch the
stack, but do not bend it.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray-full indicator.

NOTE: If the tray is not adjusted correctly,
an error message might display during printing
or the paper might jam.

 

4. Slide the tray into the product.  
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3 Parts, supplies, and accessories

● Order parts, accessories, and supplies

● HP policy on non-HP supplies

● HP anticounterfeit Web site

● Print when a toner cartridge is at estimated end of life

● Enable or disable the At Very Low settings

● Customer self-repair parts

● Accessories

● Toner cartridges

● Toner collection unit
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Order parts, accessories, and supplies

HP original toner cartridges and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.
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HP policy on non-HP supplies
Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or
remanufactured.

NOTE: For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does
not affect either the warranty to the customer or any HP support contract with the customer. However, if
product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.
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HP anticounterfeit Web site
Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the toner cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Print when a toner cartridge is at estimated end of
life

Black Low: The product indicates when a toner cartridge level is low. Actual toner cartridge life
remaining may vary. Consider having a replacement available to install when print quality is no longer
acceptable. The toner cartridge does not need to be replaced now.

Black Very Low: The product indicates when the toner cartridge level is very low. Actual toner
cartridge life remaining may vary. Consider having a replacement available to install when print
quality is no longer acceptable. The toner cartridge does not need to be replaced now unless the print
quality is no longer acceptable.

Once an HP toner cartridge has reached “very low”, HP’s Premium Protection Warranty on that toner
cartridge has ended.

You can change the way the product reacts when supplies reach the Very Low state. You do not have
to re-establish these settings when you install a new toner cartridge.
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Enable or disable the At Very Low settings
You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new toner cartridge.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge

● Very Low Setting

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the toner cartridge is very low,
but to continue printing.

● Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the toner cartridge.

● Select the Prompt option to set the product to stop printing (including printing faxes) and
prompt you to replace the toner cartridge. You can acknowledge the prompt and continue
printing. A customer configurable option on this product is "Prompt to Remind Me in 100
pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer
convenience and is not an indication these pages will have acceptable print quality.

When the product is set to the Stop option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while stopped.

When the product is set to the Prompt option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while the
product is waiting for the prompt to be acknowledged.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner
cartridge has ended. All print defects or cartridge failures incurred when an HP toner cartridge is used
in Continue at very low mode will not be considered to be defects in materials or workmanship in the
toner cartridge under the HP Toner Cartridge Warranty Statement.
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Customer self-repair parts
The following customer self-repair parts are available for the product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are
willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot
support is not provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request
for no additional charge during the product warranty period.

NOTE: For more information, go to www.hp.com/go/learnaboutsupplies.

Table 3-1  Customer self-repair parts

Item Description Self-replacement options Part number

Front door assembly Replacement front door Mandatory CZ271-67901

Tray 1 roller kit Pickup roller and separation pad
for Tray 1

Mandatory CD644-67903

Tray 2 and 3 roller kit Feed and separation rollers for
Tray 2 and Tray 3

Mandatory CD644-67904

Duplex reverse-guide kit Replacement duplex reverse
guide

Mandatory CC468-67913

Right-door kit 500-sheet-tray right door, door
stopper, and door link

Mandatory CC468-67906

Secondary transfer-roller kit Replacement T2 roller Mandatory CD644-67914

500-sheet feeder kit (Tray 3) Replacement 500-sheet feeder Mandatory CF084-67901

HP LaserJet Printer Cabinet A storage cabinet that is installed
beneath the product

Mandatory CD644-67917
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Accessories

Item Description Part number

HP Color LaserJet 1 x 500 Paper Feeder 500-sheet paper feeder (optional Tray 3) CF084A

HP LaserJet Printer Cabinet A storage cabinet that is installed
beneath the product

CF085A

USB cable 2-meter standard USB-compatible device
connector

C6518A
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Toner cartridges
● Toner-cartridge view

● Toner-cartridge information

● Replace the toner cartridges

Toner-cartridge view

3

1
2

1 Plastic shield

2 Imaging drum

CAUTION: Do not touch the green roller. Doing so can damage the cartridge.

3 Memory chip
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Toner-cartridge information

Color Cartridge number Part number

Standard-capacity replacement black
toner cartridge

507A CE400A

High-capacity replacement black toner
cartridge

507X CE400X

Replacement cyan toner cartridge 507A CE401A

Replacement yellow toner cartridge 507A CE402A

Replacement magenta toner cartridge 507A CE403A

Environmental features: Recycle toner cartridges by using the HP Planet Partners return and
recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.

The information contained herein is subject to change without notice. For the latest supplies information
go to www.hp.com/go/lj500colorMFPM570_manuals.

Recycle toner cartridges

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Toner-cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few
minutes. Cover the imaging drum if the toner cartridge must be removed from the product for an
extended period of time.

HP policy on non-HP toner cartridges

Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP toner cartridge is not covered under the HP warranty and
service agreements.
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Replace the toner cartridges

The product uses four colors and has a different toner cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold
water. Hot water sets toner into fabric.

NOTE: Information about recycling used toner cartridges is on the toner cartridge box.

1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the handle of the used toner cartridge
and pull out to remove.

 

3. Remove the new toner cartridge from its
protective bag.
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4. Grasp both sides of the toner cartridge and
distribute the toner by gently rocking the toner
cartridge.

 

5. Remove the plastic shield from the toner
cartridge.

CAUTION: Avoid prolonged exposure to
light.

CAUTION: Do not touch the green roller.
Doing so can damage the cartridge.
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6. Align the toner cartridge with its slot and insert
the toner cartridge until it clicks into place.

 

7. Close the front door.

CAUTION: To avoid damage, make sure all
toner cartridges are fully inserted before
closing the door.
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Toner collection unit

Item Description Part number

Toner Collection Unit Receptacle for waste toner CE254A

For more information, go to www.hp.com/go/learnaboutsupplies.

Replace the toner collection unit

Replace the toner collection unit when the product control panel prompts you.

NOTE: The toner collection unit is designed for a single use. Do not attempt to empty the toner
collection unit and reuse it. Doing so could lead to toner being spilled inside the product, which could
result in reduced print quality. After use, return the toner collection unit to HP’s Planet Partners program
for recycling.

NOTE: If printing documents that require heavy toner coverage, the toner collection unit can fill
quickly. If printing these types of documents, HP recommends that you have another toner collection unit
available.

1. Open the front door. Make sure that the door
is completely open.

 

2. Grasp the blue label at the top of the toner
collection unit, and then remove the toner
collection unit from the product.
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3. Place the attached blue cap over the blue
opening at the top of the unit.

 

4. Remove the new toner collection unit from its
packaging.
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5. Insert the bottom of the new unit into the
product first, and then push the top of the unit
until it clicks into place.

 

6. Close the front door.

NOTE: If the toner collection unit is not
installed correctly, the front door does not
close completely.

 

To recycle the used toner collection unit, follow the instructions included with the new toner collection
unit.
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4 Print

● Supported print drivers (Windows)

● Change print-job settings (Windows)

● Change print-job settings (Mac OS X)

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Additional print tasks (Windows)

● Additional print tasks (Mac OS X)

● Create archival-quality prints

● Color printing

● Use HP ePrint

● Use AirPrint

● Use walk-up USB printing
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Supported print drivers (Windows)
Print drivers provide access to the product printing system. The following print drivers are available at
www.hp.com/go/lj500colorMFPM570_software.

HP PCL 6 driver ● Provided as the default driver on the in-box CD. This driver is automatically
installed unless you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single print driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.
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The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

Traditional mode ● To use this mode, download UPD from the Internet. Go to www.hp.com/go/
upd.

● Use this mode if you are installing the driver for a single computer.

● It operates with a specific product.

● If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode ● To use this mode, download UPD from the Internet. Go to www.hp.com/go/
upd.

● Dynamic mode allows you to use a single driver installation, so you can
discover and print to multiple networked HP products in any location.

● Use this mode if you are installing UPD for a workgroup.

● Do not use this mode for USB-connected products.
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Change print-job settings (Windows)
● Priority for changing print-job settings

● Change the settings for all print jobs until the software program is closed

● Change the default settings for all print jobs

● Change the product configuration settings

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (print driver): Click Properties in the Print dialog box to
open the print driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default print driver settings: The default print driver settings determine the settings used in all
print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

● Product control-panel settings: Settings changed at the product control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

The steps can vary; this procedure is most common.

1. From the software program, select the Print option.

2. Select the product, and then click Properties or Preferences.
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Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click the Windows icon in the lower-left corner of the screen, click Control
Panel, and then click Printers.

Windows 7: Click the Windows icon in the lower-left corner of the screen, and then click
Devices and Printers.

2. Right-click the print-driver icon, and then select Printing Preferences.

Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click the Windows icon in the lower-left corner of the screen, click Control
Panel, and then click Printers.

Windows 7: Click the Windows icon in the lower-left corner of the screen, and then click
Devices and Printers.

2. Right-click the print-driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Change print-job settings (Mac OS X)
● Priority for changing print-job settings

● Change the settings for all print jobs until the software program is closed

● Change the default settings for all print jobs

● Change the product configuration settings

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Product control-panel settings: Settings changed at the procuct control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

4. For each menu, select the print settings that you want to change.

5. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.
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3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

4. For each menu, select the print settings that you want to save for reuse.

5. In the Presets menu, click the Save As... option, and enter a name for the preset.

6. Click the OK button.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

Change the product configuration settings

1. At the computer, open the Apple  menu, click the System Preferences item, and then click
the Print & Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Print tasks (Windows)
● Use a printing shortcut (Windows)

● Create printing shortcuts (Windows)

● Automatically print on both sides (Windows)

● Manually print on both sides (Windows)

● Print multiple pages per sheet (Windows)

● Select the page orientation (Windows)

● Select the paper type (Windows)

● Print the first or last page on different paper (Windows)

● Scale a document to fit page size (Windows)

● Create a booklet (Windows)

Use a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts. Click the OK
button to close the Document Properties
dialog box.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the print driver.

 

5. In the Print dialog box, click the OK button to
print the job.
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Create printing shortcuts (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  
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4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, all your adjustments are
lost.

 

5. Select the print options for the new shortcut.  

6. Click the Save As button.  
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7. Enter a name for the shortcut, and then click
the OK button.

 

8. Click the OK button to close the Document
Properties dialog box. In the Print dialog
box, click the OK button to print the job.

 

Automatically print on both sides (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

58 Chapter 4   Print ENWW



3. Click the Finishing tab.  

4. Select the Print on both sides check box.
Click the OK button to close the Document
Properties dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.
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Manually print on both sides (Windows) 

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides (manually)
check box. Click the OK button to print the
first side of the job.
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5. Retrieve the printed stack from the output bin,
and place it with the printed-side facing up in
Tray 1.

 

6. If prompted, touch the appropriate control
panel button to continue.

 

Print multiple pages per sheet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the number of pages per sheet from the
Pages per sheet drop-down list.
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5. Select the correct Print page borders,
Page order, and Orientation options.
Click the OK button to close the Document
Properties dialog box.

 

6. In the Print dialog box, click the OK button to
print the job.

 

Select the page orientation (Windows)

1. From the software program, select the Print
option.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.

Click the OK button to close the Document
Properties dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.

 

Select the paper type (Windows)

1. From the software program, select the Print
option.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.
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7. Select the option for the type of paper you are
using, and click the OK button.

 

8. Click the OK button to close the Document
Properties dialog box. In the Print dialog
box, click the OK button to print the job.

 

Print the first or last page on different paper (Windows)

1. From the software program, select the Print
option.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. In the Special pages area, click the Print
pages on different paper option, and
then click the Settings button.
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5. In the Pages in document area, select
either the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists.
Click the Add button.

 

7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.
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8. Click the OK button.  

9. Click the OK button to close the Document
Properties dialog box. In the Print dialog
box, click the OK button to print the job.

 

Scale a document to fit page size (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Effects tab.  

4. Select the Print document on option, and
then select a size from the drop-down list.

Click the OK button to close the Document
Properties dialog box.

 

5. In the Print dialog box, click the OK button to
print the job.
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Create a booklet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. Select the Print on both sides check box.  
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5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.

Click the OK button to close the Document
Properties dialog box.

 

6. In the Print dialog box, click the OK button to
print the job.
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Print tasks (Mac OS X)
● Use a printing preset (Mac OS X)

● Create a printing preset (Mac OS X)

● Automatically print on both sides (Mac OS X)

● Manually print on both sides (Mac OS X)

● Print multiple pages per sheet (Mac OS X)

● Select the page orientation (Mac OS X)

● Select the paper type (Mac OS X)

● Print a cover page (Mac OS X)

● Scale a document to fit page size (Mac OS X)

● Create a booklet (Mac OS X)

Use a printing preset (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Presets menu, select the printing preset.

4. Click the Print button.

NOTE: To use print-driver default settings, select the standard option.

Create a printing preset (Mac OS X)

Use printing presets to save the current print settings for reuse.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

4. For each menu, select the print settings that you want to save for reuse.

5. In the Presets menu, click the Save As... option, and enter a name for the preset.

6. Click the OK button.
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Automatically print on both sides (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select this product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing up in the
input tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on
each sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.
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Select the page orientation (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Click the icon that represents the page orientation that you want to use, and then click the OK
button.

5. Click the Print button.

Select the paper type (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Print a cover page (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Cover Page menu.

4. Select where to print the cover page. Click either the Before Document button or the After
Document button.

5. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

6. Click the Print button.

Scale a document to fit page size (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Paper Handling menu.
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4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select
the size from the drop-down list.

5. Click the Print button.

Create a booklet (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Open the menus drop-down list, and then click the Booklet Printing menu.

6. Click the Format Output as Booklet box, and select a binding option.

7. Select the paper size.

8. Click the Print button.
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Additional print tasks (Windows)
● Cancel a print job (Windows)

● Select the paper size (Windows)

● Select a custom paper size (Windows)

● Print watermarks (Windows)

Cancel a print job (Windows)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: If the print job is too far into the printing process, you might not have the option to
cancel it.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that currently
displays on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box displays briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click the Windows icon in the lower left corner of the screen, click
Settings, and then click Printers. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click the Windows icon in the lower left corner of the screen, and then
click Devices and Printers. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.

Select the paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.
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5. Click the OK button.

6. In the Print dialog box, click the OK button to print the job.

Select a custom paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

6. Click the Save button, and then click the Close button.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Print watermarks (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise,
the watermark is printed on each page.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.
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Additional print tasks (Mac OS X)
● Cancel a print job (Mac OS X)

● Select the paper size (Mac OS X)

● Select a custom paper size (Mac OS X)

● Print watermarks (Mac OS X)

Cancel a print job (Mac OS X)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: If the print job is too far into the printing process, you might not have the option to
cancel it.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one print job is waiting, pressing the Cancel  button clears the print job that currently
displays on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box displays briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Select the paper size (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

5. Click the Print button.

Select a custom paper size (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. In the Copies & Pages menu, click the Page Setup button.

4. From the Paper Size drop-down list, select the Manage Custom Sizes option.

5. Specify the dimensions for the page size, and then click the OK button.
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6. Click the OK button to close the Page Setup dialog.

7. Click the Print button.

Print watermarks (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Watermarks menu.

4. From the Mode menu, select the Watermark option.

5. From the Pages drop-down list, select whether to print the watermark on all pages or on the first
page only.

6. From the Text drop-down list, select one of the standard messages, or select the Custom option
and type a new message in the box.

7. Select options for the remaining settings.

8. Click the Print button.
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Create archival-quality prints
Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to
create documents that you want to preserve or archive.

NOTE: Archival-quality printing is accomplished by increasing the temperature of the fuser. Because
of the increased temperatures, the product prints at half-speed to avoid damage.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Archive Print button, and then touch the On button.
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Color printing
● Use the HP EasyColor option

● Change the color options (Windows)

● Change the color theme for a print job (Windows)

● Change the color options (Mac OS X)

● Manual color options

● Match colors

Use the HP EasyColor option

If you are using the HP PCL 6 print driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format. The
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript print driver for Mac, the HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 print driver and the HP Mac
Postscript print driver, so you do not need to make manual color adjustments. To disable the option so
you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/
Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.

Change the color options (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independently from other
settings. Click the Settings button to open the manual color-adjusment window.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. Also use this option to print draft
copies or to save color toner.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Change the color theme for a print job (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme
when printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using
a digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

● Custom Profile: Select this option to use a custom input profile to accurately control color
output (for example, to emulate a specific HP Color LaserJet product). Download custom
profiles from www.hp.com.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.
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Change the color options (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Color Options menu.

4. Click the HP EasyColor check box to clear it.

5. Open the Advanced settings.

6. Adjust the individual settings for text, graphics, and photographs.

7. Click the Print button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for
text, graphics, and photographs.

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Match colors

The process of matching product output color to a computer screen is quite complex because printers
and computer monitors use different methods of producing color. Monitors display colors by light pixels
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using an RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan, magenta,
yellow, and black) process.

Several factors can influence the ability to match printed colors to those on a monitor. These factors
include:

● Paper

● Printer colorants (inks or toners for example)

● Printing process (inkjet, press, or laser technology for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Print drivers

● Computer operating system

● Monitors and monitor settings

● Video cards and drivers

● Operating environment (humidity for example)

For most situations, the best method for matching colors on the screen to the printed page is to print
sRGB colors.
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Use HP ePrint
Use HP ePrint to print documents by sending them as an email attachment to the product's email
address from any email enabled device.

NOTE: The product must be connected to a wired or wireless network and have Internet access to use
HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. From the Home screen on the product control panel, touch the Web Services  button.

b. Touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the product's
email address on the control panel.

3. Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product email address that is before the @
symbol. You can get this code by printing the Web Services page from the product control
panel.

After you have added your product, you will have the option to customize the product email
address.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the email
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

4. To print a document, attach it to an email message sent to the product's email address. Both the
email message and the attachment will print.
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Use AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint
and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/
lj500colorMFPM570_firmware.
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Use walk-up USB printing

1. Insert the USB flash drive into the USB port on
the front of the product.

 

2. The USB Flash Drive menu opens. Touch the
arrow buttons to scroll through the options.

● Print Documents

● View and Print Photos

● Scan to USB Drive

 

3. To print a document, touch the Print Documents
screen, and then touch the name of the folder
on the USB drive where the document is
stored. When the summary screen opens, you
can touch it to adjust the settings. Touch the
Print button to print the document.

 

4. To print photos, touch the View and Print
Photos screen, and then touch the preview
image to select each photo that you want to
print. Touch the Done button. When the
summary screen opens, you can touch it to
adjust the settings. Touch the Print button to
print the photos.

 

5. Retrieve the printed job from the output bin,
and remove the USB flash drive.
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5 Copy

● Set new default copy settings

● Restore copy default settings

● Make a single copy

● Make multiple copies

● Copy a multiple-page original

● Copy identification cards

● Collate a copy job

● Copy on both sides (duplex)

● Reduce or enlarge a copy

● Make color or black and white copies

● Optimize copy quality

● Adjust the lightness or darkness for copies

● Adjust the copy image

● Copy in draft mode

● Set the paper size and type for copying on special paper

ENWW 91



Set new default copy settings
You can save any combination of copy settings as the default settings to use for every job.

1. From the Home screen, touch the Copy button.

2. Touch the Settings button.

3. Configure the copy settings to meet your preferences, and then scroll to and touch the Set as New
Defaults button.

4. Touch the Yes button.
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Restore copy default settings
Use this procedure to restore the factory default copy settings.

1. From the Home screen, touch the Copy button.

2. Touch the Settings button.

3. Scroll to and touch the Restore Defaults button.

4. Touch the OK button to restore the defaults.
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Make a single copy
1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.

3. Touch the Black or Color button to start copying.
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Make multiple copies

1. Load the document onto the scanner glass or
into the document feeder.

 

2. If you loaded the document into the document
feeder, adjust the guides until they are snug
against the paper.

 

3. From the Home screen on the product control
panel, touch the Copy button.

 

4. Touch the arrows to change the number of
copies, or touch the existing number and enter
the number of copies.

 

5. Touch the Black or Color button to start
copying.
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Copy a multiple-page original

1. Insert the originals into the document feeder
face-up.

 

2. Adjust the guides until they are snug against
the paper.

 

3. From the Home screen, touch the Copy button.  

4. Touch the Black or Color button to start
copying.
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Copy identification cards
Use the ID Copy feature to copy both sides of identification cards, or other small-size documents, onto
the same side of one sheet of paper. The product prompts you to copy the first side and then to place
the second side on a different area of the scanner glass and copy again. The product prints both
images at the same time.

1. Load the document onto the scanner glass.  

2. From the Home screen, touch the Copy button.  

3. Touch the ID Copy button.  

4. Touch the Black or Color button to start
copying.

 

5. The product prompts you to place the next
page on a different section of the scanner
glass.

 

6. Touch the OK button if you have more pages
to copy, or touch the Done button if this is the
last page.

 

7. The product copies all pages onto one side of
a sheet of paper.
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Collate a copy job

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Collation button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Black or Color button to start
copying.
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Copy on both sides (duplex)

Copy on both sides automatically

1. Load the original documents into the document
feeder with the first page facing up, and with
the top of the page leading.

 

2. Adjust the paper guides to fit the size of the
document.

 

3. From the Home screen on the product control
panel, touch the Copy button.

 

4. Touch the Settings button.  

5. Scroll to and touch the Two-Sided button.  

6. Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

 

7. Touch the Black or Color button to start
copying.
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Copy on both sides manually

1. Place the document face-down on the scanner
glass with the upper-left corner of the page in
the upper-left corner of the glass. Close the
scanner.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button.  

4. Scroll to and touch the Two-Sided button.  

5. Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

 

6. Touch the Black or Color button to start
copying.

 

7. The product prompts you to load the next
original document. Place it on the glass, and
then touch the OK button.

 

8. Repeat this process until you have scanned the
last page. Touch the Done button to finish
printing the copies.
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Reduce or enlarge a copy

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then touch the
Reduce/Enlarge button. Touch the arrow
buttons to scroll through the options, and then
touch an option to select it.

 

4. Touch the Black or Color button to start
copying.
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Make color or black and white copies
1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.

3. Touch the Black or Color button to start copying.
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Optimize copy quality
The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy button.  

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Black or Color button to start
copying.
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Adjust the lightness or darkness for copies

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy button.  

3. On the summary screen, touch the arrow
buttons to adjust the setting.

 

4. Touch the Black or Color button to start
copying.
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Adjust the copy image

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy button.  

3. Touch the Settings button.  

4. Scroll to and touch the Image Adjustment
button.

 

5. Touch the name of the setting you want to
adjust.

● Lightness: Adjusts the lightness/darkness
setting.

● Contrast: Adjusts the contrast between the
lightest and darkest areas of the image.

● Sharpen: Adjusts clarity of text characters.

● Background Removal: Adjusts the darkness
of the background of the image. This is
especially useful for original documents
that are printed on colored paper.

● Color Balance: Adjusts the red, green, and
blue color hues.

● Grayness: Adjusts the vividness of colors.

 

6. Touch the — or + buttons to adjust the value
for the setting, and then touch the OK button.

 

7. Adjust another setting, or touch the back arrow
to return to the main copy menu.

 

8. Touch the Black or Color button to start
copying.
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Copy in draft mode
Using draft mode can use less toner. However, using draft mode can also reduce print quality.

HP does not recommend the full-time use of draft mode. If draft mode is used full-time, the toner supply
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no
longer acceptable, consider replacing the toner cartridge.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen, touch the Copy button.  

3. Touch the Settings button.  

4. Scroll to and touch the Draft Mode button.  

5. Touch the On button.  

6. Touch the Black or Color button to start
copying.
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Set the paper size and type for copying on special
paper

1. From the Home screen, touch the Copy button.

2. Touch the Settings button, and then scroll to and touch the Paper button.

3. From the list of paper sizes, touch the name of the paper size that is in Tray 1.

NOTE: The product supports these sizes for copying: Letter, Legal, and A4.

4. From the list of paper types, touch the name of the paper type that is in Tray 1.

5. Touch the Black or Color button to start copying.
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6 Scan

● Scan by using the HP Scan software (Windows)

● Scan by using the HP Scan software (Mac OS X)

● Scan to a USB flash drive

● Set up scan to network folder and scan to email features

● Scan to a network folder

● Scan to email

● Scan by using other software
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Scan by using the HP Scan software (Windows)
1. Double-click the HP Scan icon on the computer desktop.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.
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Scan by using the HP Scan software (Mac OS X)
1. Open the HP Scan software, which is located in the Hewlett-Packard folder inside the

Applications folder.

2. Follow the on-screen instructions to scan the document.

3. When you have scanned all the pages, click the Send button to print the pages or save them to a
file.
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Scan to a USB flash drive
1. Load the document onto the scanner glass or into the document feeder.

2. Insert a USB flash drive into the port on the front of the product.

3. From the Home screen on the product control panel, touch the Scan button.

4. Touch the Scan to USB Drive screen.

5. Touch the Scan button to scan and save the file. The product creates a folder named HPSCANS
on the USB drive, and it saves the file in .PDF or .JPG format using an automatically generated file
name.

NOTE: When the summary screen opens, you can touch it to adjust settings.

You also can change the folder name.
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Set up scan to network folder and scan to email
features

To use these scan features, the product must be connected to a network. These scan features are not
available until you configure them. Use the Scan to Network Folder Setup Wizard after you install the
product software, or use the HP Embedded Web Server to configure these features. The following
instructions describe configuring the scan features by using the HP Embedded Web Server.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Scan tab to set up the features.

NOTE: To set up the scan to email feature, you need to know the name of the SMTP server that you
use. Ask your network administrator or your Internet service provider for this information. If the SMTP
server requires authentication, you also need to know the SMTP User ID and password.
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Scan to a network folder
Use the product control panel to scan a document and save it to a folder on the network.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Scan button.

3. Touch the Scan to Network Folder item.

4. In the list of network folders, select the folder to which you want to save the document.

5. The control panel screen displays the scan settings.

● If you want to change any of the settings, touch the Settings button, and then change the
settings.

● If the settings are correct, go to the next step.

6. Touch the Scan button to start the scan job.
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Scan to email
Use the product control panel to scan a file directly to an email address. The scanned file is sent to the
address as an email message attachment.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Scan button.

3. Touch the Scan to E-mail item.

4. Touch the Send an E-mail item.

5. Select the From address that you want to use. This is also known as an “outgoing email profile.”

NOTE: If the PIN feature has been set up, enter the PIN and touch the OK button. However, a
PIN is not required to use this feature.

6. Touch the To button and pick the address or group to which you want to send the file. Touch the
Done button when finished.

7. Touch the Subject button if you would like to add a subject line

8. Touch the Next button.

9. The control panel screen displays the scan settings.

● If you want to change any of the settings, touch the Settings button, and then change the
settings.

● If the settings are correct, go to the next step.

10. Touch the Scan button to start the scan job.
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Scan by using other software
If you install the full product software, the product is TWAIN-compliant and Windows Imaging
Application (WIA)-compliant. If you install the minimum product software, the product is WIA-compliant.
The product works with Windows-based programs that support TWAIN-compliant or WIA-compliant
scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

For Mac OS X, scan by using the Readiris OCR program that is available on the product CD.

Scan from a TWAIN-compliant program (Windows)

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If the
program does not start automatically, the image goes to the TWAIN-compliant program immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program (Windows)

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From
Scanner or Camera in the Insert or File menu. If you are unsure whether the program is WIA-
compliant, see the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the
Hardware and Sound folder for Windows Vista and Windows 7), double-click the product icon.
This opens the standard Microsoft WIA Wizard, which enables you to scan to a file.

Scan by using optical character recognition (OCR) software

The Readiris OCR program is included on a separate CD that shipped with the product. To use the
Readiris program, install it from the appropriate software CD, and then follow the instructions in the
online Help.
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7 Fax

● Connect fax to a telephone line

● Set up fax with a telephone answering machine

● Set up fax with an extension phone

● Setup for stand-alone fax

● Configure the fax time, date, and header

● Use special characters in fax headers

● Use the phone book

● Create and edit speed-dial entries

● Delete speed-dial entries

● Create and edit group-dial entries

● Delete group-dial entries

● Configure send fax settings

● Configure receive fax settings

● Set fax polling

● Use fax
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Connect fax to a telephone line

1. Connect the telephone cable to the line port 
on the product and to the telephone jack on
the wall.

 

The product is an analog device. HP recommends using the product on a dedicated analog telephone
line.

NOTE: Some countries/regions might require an adapter to the telephone cable that came with the
product.

Set up fax with a telephone answering machine
● Set the product rings-to-answer setting for at least one ring more than the number of rings for

which the answering machine is set.

● If an answering machine is connected to the same telephone line but on a different jack (in
another room, for example), it might interfere with the product's ability to receive faxes.

Set up fax with an extension phone
With this setting turned on, you can alert the product to pick up the incoming fax call by pressing 1-2-3
sequentially on the telephone keypad. The default setting is On. Turn this setting off only if you use
pulse dialing or if you have a service from your telephone company that also uses the 1-2-3 sequence.
The telephone company service does not work if it conflicts with the product.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Fax Setup menu.

3. Scroll to and touch the Advanced Setup button.

4. Scroll to and touch the Extension Phone button, and touch the On button.
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Setup for stand-alone fax
1. Unpack and set up the product.

2. From the Home screen on the product control panel, touch the Setup  button.

3. Touch the Fax Setup menu.

4. Touch the Fax Set-Up Utility button.

5. Follow the on-screen prompts and select the appropriate response for each question.

NOTE: The maximum number of characters for the fax number is 20.

NOTE: The maximum number of characters for the fax header is 25.
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Configure the fax time, date, and header

Use the control panel

To use the control panel to set the date, time, and header, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Time/Date button.

5. Select the 12-hour clock or 24-hour clock.

6. Use the keypad to enter the current time, and then touch the OK button.

7. Select the date format.

8. Use the keypad to enter the current date, and then touch the OK button.

9. Touch the Fax Header menu.

10. Use the keypad to enter your fax number, and then touch the OK button.

NOTE: The maximum number of characters for the fax number is 20.

11. Use the keypad to enter your company name or header, and then touch the OK button.

NOTE: The maximum number of characters for the fax header is 25.

Use the HP Fax Setup Wizard

If you did not complete the fax setup process at the time you installed the software, you can complete it
at any time by using the HP Fax Setup Wizard.

1. Click Start, and then click Programs.

2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3. Follow the onscreen instructions in the HP Fax Setup Wizard to configure the fax settings.

Use special characters in fax headers
When using the control panel to enter your name in the header or to enter a name for a one-touch key,
speed-dial entry, or group-dial entry, touch the 123 button to open a keypad that contains special
characters.
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Use the phone book
You can store frequently dialed fax numbers (up to 120 entries) either as individual fax numbers or as
groups of fax numbers.

● Use the control panel to create and edit the fax phone book

● Delete phone book entries

Use the control panel to create and edit the fax phone book

1. From the Home screen on the product control
panel, touch the Fax button.

 

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Individual Setup button to create a
speed dial entry.

 

5. Touch an unassigned number from the list.  

6. Use the keypad to enter a name for the entry,
and then touch the OK button.

 

7. Use the keypad to enter the fax number for the
entry, and then touch the OK button.

 

Delete phone book entries

You can delete all phone book entries that are programmed in the product.

CAUTION: After phone book entries are deleted, they cannot be recovered.

1. From the Home screen on the product control
panel, touch the Fax button.

 

2. Touch the Fax Menu button.  

3. Touch the Phone Book Setup button.  

4. Touch the Delete Entry button. Or, to delete all
the entries, touch the Delete All Entries button.

 

5. Touch the entry that you want to delete.  

6. Touch the OK button to confirm the deletion.  
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Create and edit speed-dial entries
1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.

4. Touch the Individual Setup button.

5. Touch an unassigned number from the list.

6. Use the keypad to enter a name for the entry, and then touch the OK button.

7. Use the keypad to enter the fax number for the entry, and then touch the OK button.
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Delete speed-dial entries
1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.

4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

5. Touch the entry that you want to delete.

6. Touch the OK button to confirm the deletion.
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Create and edit group-dial entries
1. Create an individual entry for each fax number that you want in the group.

a. From the Home screen on the product control panel, touch the Fax button.

b. Touch the Fax Menu button.

c. Touch the Phone Book Setup button.

d. Touch the Individual Setup button.

e. Touch an unassigned number from the list.

f. Use the keypad to enter a name for the entry, and then touch the OK button.

g. Use the keypad to enter the fax number for the entry, and then touch the OK button.

2. From the Phone Book Setup menu, touch the Group Setup button.

3. Touch an unassigned number from the list.

4. Use the keypad to enter a name for the group, and then touch the OK button.

5. Touch the name of each individual entry that you want to include in the group. When you are
finished, touch the Done Selecting button.
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Delete group-dial entries
1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.

4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

5. Touch the entry that you want to delete.

6. Touch the OK button to confirm the deletion.
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Configure send fax settings
● Set special dialing symbols and options

● Set the dial tone detection

● Set autoredial and the time between redials

● Set light/dark and resolution

● Set billing codes

Set special dialing symbols and options

You can insert pauses into a fax number that you are dialing. Pauses are often needed when dialing
internationally or connecting to an outside line.

Special symbol Button Description

Dialing pause The Redial/Pause button is available on the control panel keypad for
entering a fax number. You can also touch the comma button to insert a
dialing pause.

Pause for dial tone The W button is available only when you are entering the fax number for a
phone book entry. This character causes the product to wait for a dial tone
before dialing the remainder of the telephone number.

Hook flash The R button is available only when you are entering the fax number for a
phone book entry. This character causes the product to insert a hook flash.

Set a dialing prefix

A dial prefix is a number or group of numbers that are automatically added to the beginning of every
fax number you enter at the control panel or from the software. The maximum number of characters for
a dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is active, you can dial a fax number without the dial prefix by using manual dial.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Dial Prefix button, and then touch the On button.

5. Use the keypad to enter the prefix, and then touch the OK button. You can use numbers, pauses,
and dialing symbols.
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Set the dial tone detection

Normally, the product begins dialing a fax number immediately. If you are using the product on the
same line as your telephone, turn on the detect-dial-tone setting. This prevents the product from sending
a fax while someone is on the telephone.

The factory-set default for detect dial tone is On for France and Hungary, and Off for all other
countries/regions.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Detect Dial Tone button, and then touch the On button.

Tone dial or pulse dial

Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

NOTE: The pulse-dialing option is not available in all countries/regions.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Dialing Mode button, and then touch the Tone or Pulse button.

Set autoredial and the time between redials

If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

Set the redial-on-busy option

If this option is on, the product redials automatically if it receives a busy signal. The factory-set default
for the redial-on-busy option is On.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Busy button, and then touch the On button.
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Set the redial-on-no-answer option

If this option is on, the product redials automatically if the receiving machine does not answer. The
factory-set default for the redial-on-no-answer option is Off.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if No Answer button, and then touch the On button.

Set the redial-on-communication-error option

If this option is on, the product redials automatically if some sort of communication error occurs. The
factory-set default for the redial-on-communication-error option is On.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Comm. Error button, and then touch the On button.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Lighter/Darker button, and then touch one of the arrows to adjust the slider.

Set resolution settings

NOTE: Increasing the resolution increases the fax file size. Larger faxes increase the send time and
could exceed the available memory in the product.

Use this procedure to change the default resolution for all fax jobs to one of the following settings:

● Standard: This setting provides the lowest quality and the fastest transmission time.

● Fine: This setting provides a higher resolution quality than Standard that is usually appropriate for
text documents.
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● Superfine: This setting is best used for documents that mix text and images. The transmission time
is slower than the Fine setting but faster than the Photo setting.

● Photo: This setting produces the best images, but greatly increases the transmission time.

The factory-set default resolution setting is Fine.

Set the default resolution setting

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fax Resolution button, and then touch one of the options.

Set billing codes

If the billing codes feature is on, the product prompts you to enter a billing code for each fax. The
product increases the billing code count for each sent fax page. This includes all types of faxes except
for poll-received, fax-forwarded, or computer-downloaded faxes. For an undefined group or a group-
dial fax, the product increases the billing code count for each successful fax that is sent to each
destination.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1
through 250.

Set the billing-code setting

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Billing Codes button, and then touch the On button.

Use billing codes

1. Load the document in the document feeder or on the scanner glass.

2. From the Home screen on the product control panel, touch the Fax button.

3. Enter the fax number, or select a speed-dial or group-dial entry.

4. Touch the Start Fax button.

5. Enter the billing code, and then touch the OK button.

Print the billing-code report

The billing-code report is a printed list of all the fax billing codes and the total number of faxes billed to
each code.
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NOTE: After the product prints this report, it deletes all billing data.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Scroll to and touch the Print Billing Report button.
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Configure receive fax settings
● Set fax forwarding

● Set the answer mode

● Block or unblock fax numbers

● Set the number of rings-to-answer

● Set distinctive ring

● Use autoreduction for incoming faxes

● Set fax reprint settings

● Set the fax sounds volume

● Set stamp-received faxes

● Set the private receive feature

Set fax forwarding

You can set your product to forward incoming faxes to another fax number. When the fax arrives at
your product, it is stored in the memory. The product then dials the fax number that you have specified
and sends the fax. If the product cannot forward a fax because of an error (for example, the number is
busy) and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only
forwards the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Forward Fax button, and touch the On button.

5. Use the keypad to enter the fax-forwarding number, and then touch the OK button.

Set the answer mode

Depending on the situation, set the product answer mode to Automatic, TAM, Fax/Tel, or Manual. The
factory-set default is Automatic.

● Automatic: The product answers incoming calls after a specified number of rings or upon
recognition of special fax tones.

● TAM: The product does not automatically answer the call. Instead, it waits until it detects the fax
tone.
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● Fax/Tel: The product answers incoming calls immediately. If it detects the fax tone, it processes the
call as a fax. If it does not detect the fax tone, it creates an audible ring to alert you to answer the
incoming voice call.

● Manual: The product never answers calls without intervention. You must start the fax-receiving
process yourself, either by touching the Start Fax button on the control panel or by picking up a
telephone that is connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Scroll to and touch the Answer Mode button, and then touch the name of the option that you want
to use.

Block or unblock fax numbers

If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that number
sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print,
and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with
a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.

NOTE: The sender of a blocked fax is not notified that the fax failed.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Block Junk Faxes button.

5. Touch the Add Number button.

6. Use the keypad to enter the fax number that you want to block, and then touch the OK button.

Set the number of rings-to-answer

When the answer mode is set to Automatic, the product rings-to-answer setting determines the number
of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of rings-
to-answer for the product must be greater than the rings-to-answer on the answering machine. This
allows the answering machine to answer the incoming call and record a message if it is a voice call.
When the answering machine answers the call, the product listens to the call and automatically
answers it if it detects fax tones.
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The default setting for rings-to-answer is five for the U.S. and Canada, and two for other countries/
regions.

Use the following table to determine the number of rings-to-answer to use.

Type of telephone line Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls) Set to a number of rings within the range shown on the
control-panel display. (The minimum and maximum number of
rings allowed varies by country/region.)

One line with two separate numbers and a ring-pattern
service

One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make sure
that the product is set to a greater number of rings than the
answering system. Also, use the distinctive-ring feature to
differentiate between voice and fax calls.)

Shared line (receiving both fax and voice calls) with only an
attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.

To set or change the number of rings-to-answer, use the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Rings to Answer button.

5. Use the keypad to enter the number of rings, and then touch the OK button.

Set distinctive ring

Ring-pattern or distinctive-ring service is available through some local telephone companies. The service
provides a way to have more than one telephone number on a single line. Each telephone number has
a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer
the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone
company to determine if this service is available in your country/region.

NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to something
other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

● All Rings: The product answers any calls that come through the telephone line.

● Single: The product answers any calls that produce a single-ring pattern.

● Double: The product answers any calls that produce a double-ring pattern.
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● Triple: The product answers any calls that produce a triple-ring pattern.

● Double and Triple: The product answers any calls that produce a double-ring or triple-ring pattern.

To change ring patterns for call answering, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Basic Setup menu.

4. Touch the Distinctive Ring button, and then touch the name of an option.

Use autoreduction for incoming faxes

If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set
default for incoming fax autoreduction is On.

If you have the Stamp Faxes option turned on, you might also want to turn on autoreduction. This
reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax onto
two pages.

NOTE: Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Set fax reprint settings

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and then touch the On button.
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Set the fax sounds volume

Use this setting to control the volume of the fax sounds from the control panel. You can make changes
to the following sounds:

● Alarm Volume

● Ring Volume

● Phone Line Volume

Set the alarm volume, phone-line volume, and ring volume

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the System Setup menu.

3. Touch the Volume Settings menu.

4. Touch the name of the volume setting that you want to adjust, and then touch one of the options.
Repeat this step for each volume setting.

Set stamp-received faxes

The product prints the sender identification information at the top of each received fax. You can also
stamp the incoming fax with your own header information to confirm the date and time that the fax was
received. The factory-set default for stamp-received faxes is Off.

NOTE: Turning on the stamp-received setting might increase the page size and cause the product to
print a second page.

NOTE: This option applies only to received faxes that the product prints.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Stamp Faxes button, and then touch the On button.

Set the private receive feature

When the private-receive feature is active, received faxes are stored in memory. A password is
required to print the stored faxes.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

ENWW Configure receive fax settings 135



4. Scroll to and touch the Private Receive button, and then touch the On button.

5. If you have not already set a system password, the product prompts you to create one.

NOTE: The system password is case-sensitive.

a. Touch the OK button, and then use the keypad to enter the system password.

b. Touch the OK button, confirm the password by entering it a second time, and then touch the
OK button to save the password.

Set fax polling
If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This
is known as polling another machine).

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Polling Receive button.

5. Use the keypad on the touchscreen to enter the number of the fax machine that you want to poll,
and then touch the OK button.

The product dials the other fax machine and requests the fax.
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Use fax
● Supported fax programs

● Cancel a fax

● Delete faxes from memory

● Use fax on a DSL, PBX, or ISDN system

● Use fax on a VoIP service

● Fax memory contents are retained when there is a loss of power

● Security issues when connecting internal networks to public phone lines

● Fax from the flatbed scanner

● Fax from the document feeder

● Use speed dials and group-dial entries

● Send a fax from the software (Windows)

● Send a fax by dialing from a telephone connected to the fax line

● Send a fax with confirmation

● Schedule a fax to be sent later

● Send a fax combining an electronic and paper document

● Use access codes, credit cards, or calling cards

● Print a fax

● Reprint a fax

● Automatically print on both sides of received faxes

● Receive faxes when fax tones are audible on the phone line

● Print a stored fax when the private receive feature is on

Supported fax programs

The PC fax program that came with the product is the only PC fax program that works with the product.
To continue to use a PC fax program previously installed on the computer, use the modem that is
already connected to the computer; it will not function through the product modem.

Cancel a fax

Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or
received.
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Cancel the current fax

Press the Cancel  button on the control panel. Any pages that have not been transmitted are
canceled. Pressing the Cancel  button also stops group-dial jobs.

Cancel a pending fax job

Use this procedure to cancel a fax job in the following situations:

● The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

● The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job Status menu:

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Send Options button.

4. Touch the Fax Job Status button.

5. Touch the fax number for the job that you want to cancel.

Delete faxes from memory

Use this procedure only if you are concerned that someone else has access to your product and might
try to reprint faxes from the memory.

CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Clear Saved Faxes button.

Use fax on a DSL, PBX, or ISDN system

HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VoIP services, but they work with the proper setup and
equipment.

NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service provider.

The HP LaserJet product is an analog device that is not compatible with all digital phone environments
(unless a digital-to-analog converter is used). HP does not guarantee that the product will be compatible
with digital environments or digital-to-analog converters.
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DSL

A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with those digital signals. However, if the configuration is specified
during DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an
analog signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.

NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.

A typical DSL modem employs a filter to separate the higher frequency DSL modem communication
from lower frequency analog phone and fax modem communication. It is often necessary to use a filter
with analog phones and analog fax products that are connected to a telephone line used by a DSL
modem. The DSL service provider usually provides this filter. Contact the DSL provider for more
information or for assistance.

PBX

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX
environment, it might be necessary to contact the PBX provider for assistance. HP does not guarantee
that the product will be compatible with digital environments or digital-to-analog converters.

Contact the PBX provider for more information and for assistance.

ISDN

The product is an analog device that is not compatible in all digital phone environments. Digital-to-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in an ISDN
environment, it might be necessary to contact the ISDN provider for assistance. HP does not guarantee
that the product will be compatible with ISDN digital environments or digital-to-analog converters.

Use fax on a VoIP service

Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VoIP
network.

If the VoIP provider offers a "Pass through" mode for the connection, that will offer better fax
performance on VoIP. Also if the provider has "comfort noise" added to the line, fax performance can
be enhanced if this feature is not enabled.

If faxing problems continue, contact the VoIP provider.

Fax memory contents are retained when there is a loss of power

The flash memory protects against data loss when a power failure occurs. Other fax devices store fax
pages in either normal RAM or short-term RAM. Normal RAM immediately loses data when power is

ENWW Use fax 139



lost, while short-term RAM loses data about 60 minutes after a power failure occurs. Flash memory can
maintain its data for years without power applied.

Security issues when connecting internal networks to public phone
lines

The product can send and receive fax data over telephone lines that conform to public switch telephone
network (PSTN) standards. The secure fax protocols make it impossible for computer viruses to be
transferred from the telephone line to a computer or network.

The following product features prevent virus transmission:

● No direct connection exists between the fax line and any devices that are connected to the USB or
Ethernet ports.

● The internal firmware cannot be modified through the fax connection.

● All fax communications go through the fax subsystem, which does not use Internet data-exchange
protocols.

Fax from the flatbed scanner

1. Place the document face-down on the scanner
glass.

 

2. From the Home screen on the product control
panel, touch the Fax button.

 

3. Use the keypad to enter the fax number.  

4. Touch the Start Fax button.  

5. The product prompts you to confirm that you
are sending from the scanner glass. Touch the
Yes button.

 

6. The product prompts you to load the first page.
Touch the OK button.
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7. The product scans the first page and then
prompts you to load another page. If the
document has multiple pages, touch the Yes
button. Continue this process until you have
scanned all the pages.

 

8. When you have scanned the last page, touch
the No button at the prompt. The product
sends the fax.

 

Fax from the document feeder

1. Insert the originals into the document feeder
face-up.

NOTE: The document feeder capacity is up
to 50 sheets of 75 g/m2 (20 lb) paper.

CAUTION: To prevent damage to the
product, do not use an original that contains
correction tape, correction fluid, paper clips,
or staples. Also, do not load photographs,
small originals, or fragile originals into the
document feeder.

 

2. Adjust the paper guides until they are snug
against the paper.

 

3. From the Home screen on the product control
panel, touch the Fax button.

 

4. Use the keypad to enter the fax number.  

5. Touch the Start Fax button.  
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Use speed dials and group-dial entries

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Fax button.

 

3. On the keypad, touch the fax phone book
icon.

 

4. Touch the name of the individual or group
entry that you want to use.

 

5. Touch the Start Fax button.  

Send a fax from the software (Windows)

The following information provides basic instructions for sending faxes by using the software that came
with the product. All other software-related topics are covered in the software Help, which can be
opened from the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

● The product is connected directly to the computer or to a network to which the computer is
connected.

● The product software is installed on the computer.

● The computer operating system is one that this product supports.

Send a fax from the software

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click HP.

2. Click the product name, and then click Send fax. The fax software opens.
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3. Enter the fax number of one or more recipients.

4. Load the document in the document feeder.

5. Click Send Now.

Send a fax from a third-party software program, such as Microsoft Word

1. Open a document in a third-party program.

2. Click the File menu, and then click Print.

3. Select the fax print driver from the print driver drop-down list. The fax software opens.

4. Enter the fax number of one or more recipients.

5. Include any pages loaded at the product. This step is optional.

6. Click Send Now.
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Send a fax by dialing from a telephone connected to the fax line

Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual
receive mode, you can precede the fax with a voice call to let that person know that the fax is coming.

NOTE: The telephone must be connected to the product "telephone" port .

1. Load the document into the document feeder.

2. From the Home screen on the product control panel, touch the Fax button.

3. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

4. When the recipient answers, instruct the person to start the fax machine.

5. When you hear the fax tones, touch the Start Fax button on the control panel, wait until the control
panel displays the Connecting message, and then hang up the telephone.

Send a fax with confirmation

You can set the product so that it prompts you to enter the fax number a second time to confirm that you
are sending the fax to the correct number.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Confirm Fax Number button, and touch the On button.

5. Send the fax.

Schedule a fax to be sent later

Use the product control panel to schedule a fax to be sent automatically at a future time to one or more
people. When this procedure is completed, the product scans the document into memory and then
returns to the Ready state.

NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial
attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same time
are delivered as individual faxes.
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1. Load the document into the document feeder.  

2. From the Home screen on the product control
panel, touch the Fax button.

 

3. Touch the Fax Menu button.  

4. Touch the Send Options button.  

5. Touch the Send Fax Later button.  

6. Use the keypad to enter the time of day to
send the fax. Touch the OK button.

 

7. Use the keypad to enter the date to send the
fax. Touch the OK button.

 

8. Use the keypad to enter the fax number. Touch
the OK button. The product scans the
document and saves it in memory until the
designated time.

 

Send a fax combining an electronic and paper document

Use the HP Send Fax software to set up this feature. To start the software program, from the Windows
Start menu, navigate to the program group for this product, and then click the HP Send Fax item.
Use the software to combine the documents into a single fax job.

Use access codes, credit cards, or calling cards

To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing
codes.

Send faxes internationally

To send a fax to an international destination, dial manually to allow for pauses and international
dialing codes.
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Print a fax

When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.
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Reprint a fax

When the Allow Fax Reprint feature is on, the product stores received faxes in memory. The product
has about 3.2 MB of storage space, which holds about 250 pages.

These faxes are stored continuously. Reprinting them does not clear them from the memory.

The default setting for this feature is Off.

Turn on the Allow Fax Reprint feature

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and touch the On button.

Reprint faxes

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Reprint Faxes button.

5. Touch the entry for the fax that you want to reprint.
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Automatically print on both sides of received faxes

Use the product control panel to configure the product to print two-sided copies of received faxes.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup button.

3. Touch the Advanced Setup button.

4. Touch the Print Duplex button.

5. Touch the On button.

Receive faxes when fax tones are audible on the phone line

If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:

● Touch the Start Fax button on the product control panel.

● Press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and then
hang up.

NOTE: For the second method to work, the Extension Phone option must be turned on. This option is
one of the Advanced Setup options in the Fax Setup menu.

Print a stored fax when the private receive feature is on

To use this feature, you must enable the Private Receive feature on the product. Use the following
procedure to enable this feature.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup button.

3. Touch the Advanced Setup button

4. Scroll to and touch the Private Receive button.

5. Touch the On button.

To print stored faxes, you must provide the product security password. After the product prints the
stored faxes, the faxes are deleted from memory.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Print Private Faxes button.

5. Use the keypad on the touchscreen to enter the product security password, and then touch the OK
button.
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8 Manage and maintain

● Use the HP Reconfiguration Utility to change the product connection (Windows)

● Set up HP Wireless Direct Printing

● Use HP Web Services applications

● Configure IP network settings

● HP Device Toolbox (Windows)

● HP Utility for Mac OS X

● Use HP Web Jetadmin software

● Economy settings

● Product security features

● Upgrade the firmware
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Use the HP Reconfiguration Utility to change the
product connection (Windows)

If you are already using the product and you wish to change the way it is connected, use the
HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use
a different wireless address, to connect to a wired or wireless network, or change from a network
connection to a USB connection. You can change the configuration without inserting the product CD.
After you select the type of connection you wish to make, the program goes directly to the portion of
the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
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Set up HP Wireless Direct Printing
NOTE: This feature is available with wireless models only.

The HP Wireless Direct Printing feature lets you print from your wireless mobile device directly to an
HP Wireless Direct-enabled product without requiring connection to an established network or the
Internet. Use HP Wireless Direct to print wirelessly from the following devices:

● iPhone, iPad, or iTouch using Apple AirPrint

● Mobile devices that run Android, iOS, or Symbian using the HP ePrint Home & Biz application

To set up HP Wireless Direct from the control panel, complete the following steps:

NOTE: This feature requires you to set up a security password for the product. If you have not
previously configured a password, you are prompted to configure one after you enable the feature.

1. From the Home screen on the product control panel, touch the Wireless  button.

2. Open the following menus:

● Wireless Menu

● Wireless Direct Settings

● On/Off

NOTE: If the Wireless Direct Settings item does not appear on the control panel, you need to
upgrade the product firmware. To get the current version, go to www.hp.com, enter the
HP product number in the search box, select the specific product model, and then click the
Software & Driver Downloads link.

3. Touch the On menu item. The product might prompt you to set a security password. The product
saves the setting and then returns the control panel to the Wireless Direct Settings menu.
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Use HP Web Services applications
1. From the Home screen on the product control panel, touch the Web Services  button.

2. Touch the Enable Web Services button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu
on the product control panel. This process enables both HP Web Services and the Apps menu.
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Configure IP network settings
● Printer sharing disclaimer

● View or change network settings

● Manually configure IPv4 TCP/IP parameters from the control panel

● Rename the product on a network

● Link speed and duplex settings

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, enter the IP address into the address line of a Web
browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the TCP/IP Config menu, and then touch the Manual button.

4. Use the keypad on the touchscreen to enter the IP address, and touch the OK button. Touch the
Yes button to confirm.

5. Use the keypad on the touchscreen to enter the subnet mask, and touch the OK button. Touch the
Yes button to confirm.

6. Use the keypad on the touchscreen to enter the default gateway, and touch the OK button. Touch
the Yes button to confirm.
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Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the
HP Embedded Web Server.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Status field. You
can change this name to uniquely identify this product.

NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.
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Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings
might prevent the product from communicating with other network devices. If you need to make
changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network hub,
switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the Link Speed menu.

4. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Full 10 Mbps, full-duplex operation

10T Half 10 megabytes per second (Mbps), half-duplex operation

100TX Full 100 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

1000T Full 1000 Mbps, full-duplex operation

5. Touch the OK button. The product turns off and then on.
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HP Device Toolbox (Windows)
Use the HP Device Toolbox for Windows to check product status or to view or change product settings
from your computer. This tool opens the HP Embedded Web Server for the product.

NOTE: This tool is available only if you performed a full installation when you installed the product.
Depending on how the product is connected, some features might not be available.

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Tab or section Description

Home tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the approximate percent life
remaining of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies.
Actual supply life remaining can vary. Consider having a replacement supply
available to install when print quality is no longer acceptable. The supply does not
need to be replaced unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration
page.

● Network Summary: Shows the information found on the product network
configuration page.

● Reports: Print the configuration and supplies status pages that the product
generates.

● Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Change the default paper-handling settings for the product.

● Print Quality: Change the default print-quality settings for the product, including
calibration settings.

● Paper Types: Configure print modes that correspond to the paper types that the
product accepts.

● System Setup: Change the system defaults for the product.

● Service: Perform the cleaning procedure on the product.

● Product Security: Set or change the product password.

● Save and Restore: Save the current settings for the product to a file on the
computer. Use this file to load the same settings onto another product or to restore
these settings to this product at a later time.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the administrator before changing settings on this tab.
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Tab or section Description

Print tab

Provides the ability to change
default print settings from your
computer.

● Printing: Change the default product print settings, such as number of copies and
paper orientation. These are the same options that are available on the control
panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: Turn off or on the Print PS Errors feature.

Fax tab ● Receive Options: Configure how the product handles incoming faxes.

● Phone Book: Add or delete entries in the fax phone book.

● Junk Fax List: Set fax numbers to block from sending faxes to the product.

● Fax Activity Log: Review recent fax activity for the product.

Scan tab Configure the Scan to Network Folder and Scan to E-mail features.

● Network Folder Setup: Configure folders on the network to which the product
can save a scanned file.

● Scan to E-mail Setup: Begin the process to set up the Scan to E-mail feature.

● Outgoing E-mail Profiles: Set an email address that will appear as the “from”
address for all emails sent from the product. Configure the SMTP Server information.

● E-mail Address Book: Add or delete entries in the email address book.

● E-mail Options: Configure a default subject line and body text. Configure default
scan settings for emails.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the product
when it is connected to an IP-based network. It also allows the network administrator to
set up Wireless Direct functionality. This tab does not appear if the product is directly
connected to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.

HP Smart Install tab Use this tab to disable HP Smart Install or to download and install the product software.
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to view or change product settings from your computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-
based network.

Open HP Utility

From the Finder, double-click Applications, double-click Hewlett-Packard, and then click HP
Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple  menu, click the System Preferences menu, and then click
the Print & Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Upgrade the product firmware.

● Change the Bonjour name for the product on the Bonjour network.

● Display the color usage page.
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Use HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP products, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product
features. Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to
learn more about upgrades.
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Economy settings
● Print with EconoMode

● Set the Sleep Delay

● Set the Auto Power Down delay

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web
Server

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the Sleep Delay

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep Delay

3. Select the time for the sleep delay.

NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings
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● Auto Power Down

● Power Down Delay

3. Select the time for the power-down delay.

NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when
you touch the screen on the product control panel. You can change which events cause the
product to wake. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Wake Events

To turn off a wake event, select the event and then select the No option.
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Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

 

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on
a network.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Settings tab, and click the Security link.

NOTE: If a password has previously been set, you are prompted to provide the password. Enter
the password, and then click the Apply button.

4. Enter the new password in the New Password box and in the Verify password box.

5. At the bottom of the window, click the Apply button to save the password.
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Upgrade the firmware
HP offers periodic upgrades to the product firmware. You can load the firmware upgrades manually, or
you can set the product to automatically load firmware upgrades.

Manually upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Check For Updates Now

3. Touch the Yes button to prompt the product to search for firmware upgrades. If the product detects
an upgrade, it will begin the upgrade process.

Set the product to automatically upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Manage Updates

● Prompt Before Install

3. Touch the Install automatically option.
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9 Solve problems

● Solve problems checklist

● Restore the factory-set defaults

● Control panel help system

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● Improve copy quality

● Improve scan quality

● Improve fax quality

● The product does not print or it prints slowly

● Solve walk-up USB printing problems

● Solve fax problems

● Solve USB connection problems

● Solve wired network problems

● Solve wireless network problems

● Solve product software problems with Windows

● Solve product software problems with Mac OS X

● Remove software (Windows)

● Remove software (Mac OS X)

● Solve scan to email problems

● Solve scan to network folder problems
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection

● Step 3: Check the control panel for error messages

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Test copy functionality

● Step 8: Test the fax functionality

● Step 9: Check the toner cartridge

● Step 10: Try sending a print job from a computer

● Step 11: Verify that the product is on the network

Step 1: Make sure that the product is set up correctly

1. Press the power button to turn on the product or to deactivate the Auto Power Down mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label on
the back of the product for voltage requirements.) If you are using a power strip and its voltage is
not within specifications, connect the product directly to the wall outlet. If it is already connected to
a wall outlet, try a different outlet.

4. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection

1. Check the cable connection between the product and the computer. Make sure that the connection
is secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

3. If the product is connected to a network, check the following items:

● Check the light next to the network connection on the product. If the network is active, the
light is green.

● Make sure that you are using a network cable and not a phone cord to connect to the
network.

● Make sure the network router, hub, or switch is turned on and that it is working correctly.
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● If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

● If the product is connected wirelessly, print a Wireless Network Test Report to verify that the
wireless connection is working correctly.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Touch the Self Diagnostics button.

c. Touch the Run Wireless Test button to print the report.

4. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message displays, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the print driver for this product. Check the program to make sure that
you are using the print driver for this product.

Step 6: Test print functionality

1. Print a configuration report.

a. From the Home screen on the product control panel, touch the Information  button.

b. Touch the Report button to print the configuration report.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.
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Step 7: Test copy functionality

1. Place the configuration page into the document feeder and make a copy. If paper does not feed
smoothly through the document feeder, you might need to clean the document feeder rollers and
separation pad. Make sure the paper meets specifications for this product.

2. Place the configuration page onto the scanner glass and make a copy.

3. If the print quality on the copied pages is not acceptable, clean the scanner glass and the small
glass strip.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the scanner glass. They might seep and damage the product.

Step 8: Test the fax functionality

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● Fax Service

3. Touch the Run Fax Test button to print the Fax Test Report, which provides information about fax
functionality.

Step 9: Check the toner cartridge

Print a supplies status page and check remaining life of the toner cartridge.

1. From the Home screen on the product control panel, touch the Supplies  button.

2. Touch the Report button to print the supplies status page.

Step 10: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the
software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the paper that you
are using.

Step 11: Verify that the product is on the network

For networked products, open a Web browser, and enter the product IP address (from the previously
printed configuration page) in the address box to open the HP Embedded Web Server (EWS). If the
HP EWS does not open, reinstall the product on the network.
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Restore the factory-set defaults
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It
will not reset the page count, tray size, or language. To restore the product to the factory-default
settings, follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it
also deletes any pages that are stored in the memory.

1. On the product control panel, touch the Setup  button.

2. Scroll to and touch the Service menu.

3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
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Control panel help system
The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● The document feeder jams, skews, or picks up multiple sheets of paper

● Prevent paper jams from the paper trays

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened
with warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.
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The document feeder jams, skews, or picks up multiple sheets of
paper

● The original might have something on it, such as staples or self-adhesive notes, that must be
removed.

● Make sure that the document-feeder cover is closed.

● The pages might not be placed correctly. Straighten the pages and adjust the paper guides to
center the stack.

● The paper guides must be touching the sides of the paper stack to work correctly. Make sure that
the paper stack is straight and the guides are against the paper stack.

● Verify that there are no pieces of paper, staples, paper clips, or other debris in the paper path.

● Clean the document-feeder rollers and the separation pad. Use compressed air or a clean, lint-free
cloth moistened with warm water.

Prevent paper jams from the paper trays

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.

8. Verify that the tray is configured correctly for the paper type and size.

9. Make sure the printing environment is within recommended specifications.
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Clear jams
● Jam locations

● Clear jams in the document feeder

● Clear jams in the output bin area

● Clear jams in Tray 1

● Clear jams in Tray 2

● Clear jams in the right door

● Clear jams in optional Tray 3

● Clear jams in the lower right door (Tray 3)

Jam locations

Use this illustration to identify locations of jams. In addition, instructions display on the control panel to
direct you to the location of jammed paper and how to clear it.

NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

7

3

1

2

4

5

6

1 Output-bin area

2 Duplexing area

3 Tray 1 area

4 Optional Tray 3

5 Tray 2 pickup area

6 Fuser area

7 Document-feeder area
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Clear jams in the document feeder

1. Open the document-feeder cover.  

2. Gently pull the jammed paper out.  
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3. Close the document-feeder cover.  

4. Open the scanner lid. If paper is jammed in
the scanner lid, gently pull it out.
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp
the leading edge and remove it.
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Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the
jam by gently pulling the paper straight out.

 

2. If you cannot remove the paper, or if no
jammed paper is visible in Tray 1, close Tray
1 and open the right door.

 

3. If paper is visible inside the right door, gently
pull the trailing edge to remove it.
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4. Gently pull the paper out of the pick up area.  

5. Close the right door.  
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Clear jams in Tray 2

1. Open Tray 2 and make sure that the paper is
stacked correctly. Remove any jammed or
damaged sheets of paper.

 

2. Close the tray.  

ENWW Clear jams 179



Clear jams in the right door

CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before clearing
jams.

1. Open the right door.  

2. If paper is jammed as it enters the output bin,
gently pull the paper downward to remove it.

 

3. If paper is jammed inside the right door, gently
pull the paper to remove it.
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4. Lift the paper-feed cover on the inside of the
right door. If jammed paper is present, gently
pull the paper straight out to remove it.

 

1

2

5. Close the paper-feed cover.  

6. Gently pull the paper out of the pickup area.  

7. Look for paper in the Tray 2 roller area. Push
up on the two green tabs to release the jam-
access door. Remove any jammed paper, and
close the door.
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8. If paper is visible entering the bottom of the
fuser, gently pull downward to remove it.

CAUTION: Do not touch the rollers on the
transfer roller. Contaminants can affect print
quality.

 

9. Paper could be jammed inside the fuser where
it would not be visible. Grasp the fuser
handles, lift up slightly, and pull straight out to
remove the fuser.

CAUTION: The fuser can be hot while the
product is in use.

 

10. Open the jam-access door (callout 1). If paper
is jammed inside the fuser, gently pull it
straight up to remove it (callout 2). If the paper
tears, remove all paper fragments.

CAUTION: Even if the body of the fuser has
cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they
have cooled.

 

1

2
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11. Close the jam-access door, and push the fuser
completely into the product.

 

12. Close the right door.  
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Clear jams in optional Tray 3

1. Open Tray 3 and make sure that the paper is
stacked correctly. Remove any damaged or
jammed sheets of paper.

NOTE: To prevent jams, do not overfill the
tray. Be sure the top of the stack is below the
tray-full indicator.

 

2. Close Tray 3.  
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Clear jams in the lower right door (Tray 3)

1. Open the lower right door.  

2. If paper is visible, gently pull the jammed
paper up or down to remove it.

 

3. Close the lower right door.  
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Improve print quality
● Print from a different software program

● Set the paper-type setting for the print job

● Check the toner-cartridge status

● Calibrate the product to align the colors

● Print a cleaning page

● Perform additional print quality troubleshooting

● Inspect the toner cartridge for damage

● Check the paper and printing environment

● Check the EconoMode settings

● Adjust color settings (Windows)

● Try a different print driver

Print from a different software program

Try printing from a different software program. If the page prints correctly, the problem is with the
software program from which you were printing.

Set the paper-type setting for the print job

Check the paper type-setting if you are printing from a software program and the pages have any of
these problems:

● smeared print

● fuzzy print

● dark print

● curled paper

● scattered dots of toner

● loose toner

● small areas of missing toner

Check the paper-type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.
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4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Check the paper-type setting (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Check the toner-cartridge status

Check the supplies status page for the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Use the following procedure to print the supplies status page:

1. From the Home screen on the product control panel, touch the Supplies  button.

2. Touch the Report button to print the supplies status page.

Calibrate the product to align the colors

If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might
need to calibrate the product to align the colors. Print the diagnostics page from the Reports menu on
the control panel to check the color alignment. If the blocks of color on that page are not aligned with
each other, you need to calibrate the product.

1. On the product control panel, open the System Setup menu.

2. Open the Print Quality menu, and select the Color Calibration item.

3. Select the Calibrate Now option.
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Print a cleaning page

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

The product prints the first side and then prompts you to remove the page from the output bin and
reload it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the
page that prints.

Perform additional print quality troubleshooting

Print the print quality page

1. From the Home screen, touch the Setup  button.

2. Touch the Reports button.

3. Touch the Print Quality Page button.

Interpret the print quality page

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular toner cartridge.

Section Toner cartridge

1 Yellow

2 Cyan
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Section Toner cartridge

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the toner cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that toner cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the toner cartridge
is probably causing the problem.

Inspect the toner cartridge for damage

1. Remove the toner cartridge from the product,
and verify that the sealing tape has been
removed.

 

2. Check the memory chip for damage.  

3. Examine the surface of the imaging drum on
the bottom of the toner cartridge.

CAUTION: Do not touch the roller (imaging
drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause
print-quality problems.
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4. If you see any scratches, fingerprints, or other
damage on the imaging drum, replace the
toner cartridge.

 

5. If the imaging drum does not appear to be
damaged, rock the toner cartridge gently
several times and reinstall it. Print a few pages
to see if the problem has resolved.

 

Check the paper and printing environment

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the product environment

Verify that the product is operating within the environmental specifications listed in the product
Warranty and Legal Guide.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that
driver, you can enable the feature by using the HP Embedded Web Server.
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Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:

● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click
the OK button to print the job.

Adjust color settings (Windows)

Change the color theme

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid (sRGB): The product increases the color saturation in the midtones. Use this theme
when printing business graphics.

● Photo (sRGB): The product interprets RGB color as if it were printed as a photograph using
a digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.
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● None: No color theme is used.

● Custom Profile: Select this option to use a custom input profile to accurately control color
output (for example, to emulate a specific HP Color LaserJet product). Download custom
profiles from www.hp.com.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Change the color options

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Select the HP EasyColor check box to clear it.

5. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independently from other
settings. Click the Settings button to open the manual color-adjusment window.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

6. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. Also use this option to print draft
copies or to save color toner.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Try a different print driver

You might need to use a different print driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5
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HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and product feature support for
most users

● Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

● Might not be fully compatible with third-party and custom solutions based on
PCL5

Download additional print drivers from this Web site: www.hp.com/go/
lj500colorMFPM570_software.
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Improve copy quality
● Check the scanner glass for dirt and smudges

● Check the paper settings

● Check the image adjustment settings

● Optimize for text or pictures

● Edge-to-edge copying

● Clean the pickup rollers and separation pad in the document feeder

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off,
and then disconnect the power cable from the
electrical outlet.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.
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4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Connect the power cable to an outlet, and
then press the power button to turn the product
on.

 

Check the paper settings

1. From the Home screen on the product control panel, touch the Copy button.

2. Touch the Settings button, and then scroll to and touch the Paper button.

3. From the list of paper sizes, touch the name of the paper size that is in Tray 1.

4. From the list of paper types, touch the name of the paper type that is in Tray 1.

5. Touch the Black or Color button to start copying.

Check the image adjustment settings

1. From the Home screen, touch the Copy button.

2. Touch the Settings button, and then scroll to and touch the Image Adjustment button.

3. Touch the name of the setting you want to adjust.

● Lightness: Adjusts the lightness/darkness setting.

● Contrast: Adjusts the contrast between the lightest and darkest areas of the image.

● Sharpen: Adjusts clarity of text characters.

● Background Removal: Adjusts the darkness of the background of the image. This is especially
useful for original documents that are printed on colored paper.

● Color Balance: Adjusts the red, green, and blue color hues.

● Grayness: Adjusts the vividness of colors.
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4. Touch the — or + buttons to adjust the value for the setting, and then touch the OK button.

5. Adjust another setting, or touch the back arrow to return to the main copy menu.

6. Touch the Black or Color button to start copying.

Optimize for text or pictures

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is the
default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

 

2. From the Home screen on the product control
panel, touch the Copy button.

 

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

 

4. Touch the Start Copy button to start copying.  

Edge-to-edge copying

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x
13.7 in), leaving a 4 mm unprintable border around the page.

Considerations for printing or scanning documents with cropped edges:

● When the original is smaller than the output size, move the original 4 mm (1/6 inch) away from
the corner indicated by the icon on the scanner. Recopy or scan in this position.

● When the original is the size of the printed output that you want, use the Reduce/Enlarge feature
to reduce the image so the copy is not cropped.
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Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.  

2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document-feeder cover.  
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Improve scan quality
● Check the scanner glass for dirt and smudges

● Clean the pickup rollers and separation pad in the document feeder

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off,
and then disconnect the power cable from the
electrical outlet.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

198 Chapter 9   Solve problems ENWW



4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Connect the power cable to an outlet, and
then press the power button to turn the product
on.

 

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.  
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2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document-feeder cover.  
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Improve fax quality
● Check the scanner glass for dirt and smudges

● Check the send-fax resolution setting

● Check the error correction setting

● Send to a different fax machine

● Clean the pickup rollers and separation pad in the document feeder

● Check the fit-to-page setting

● Check the sender's fax machine

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off,
and then disconnect the power cable from the
electrical outlet.

 

2. Open the scanner lid.  
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3. Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

 

5. Connect the power cable to an outlet, and
then press the power button to turn the product
on.

 

Check the send-fax resolution setting

If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Open the Fax Resolution menu.
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Check the error correction setting

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Send to a different fax machine

Send the fax job to a different fax machine to see if another machine will successfully receive the fax
job.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.  
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2. Use a moist, lint-free cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

 

3. Close the document-feeder cover.  

Check the fit-to-page setting

If the product printed a fax job off the page, turn on the fit-to-page feature from the product control
panel.

NOTE: Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Check the sender's fax machine

Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic print drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/lj500colorMFPM570.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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Solve walk-up USB printing problems
● The USB Flash Drive menu does not open when you insert the USB flash drive

● The file does not print from the USB flash drive

● The file that you want to print is not listed in the USB Flash Drive menu

The USB Flash Drive menu does not open when you insert the USB
flash drive

1. You might be using a USB flash drive or a file system that this product does not support. Save the
files on a standard USB flash drive that uses File Allocation Table (FAT) file systems. The product
supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB flash drive.

3. The USB flash drive might have multiple partitions. (Some USB flash drive manufacturers install
software on the drive that creates partitions, similar to a CD.) Reformat the USB flash drive to
remove the partitions, or use a different USB flash drive.

4. The USB flash drive might require more power than the product can provide.

a. Remove the USB flash drive.

b. Turn the product off and then on.

c. Use a USB flash drive that has its own power supply or that requires less power.

5. The USB flash drive might not be functioning correctly.

a. Remove the USB flash drive.

b. Turn the product off and then on.

c. Try printing from another USB flash drive.

The file does not print from the USB flash drive

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
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The file that you want to print is not listed in the USB Flash Drive
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .PDF and .JPEG file types.

2. You might have too many files in a single folder on the USB flash drive. Reduce the number of files
in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve fax problems
● Checklist for solving fax problems

● Perform a fax diagnostic test

● Fax trace report

● Fax error report printing

● Set the fax-error-correction mode

● Change the fax speed

● Solve problems sending faxes

● Solve problems receiving faxes

● Solve general fax problems

Checklist for solving fax problems

● Several possible fixes are available. After each recommended action, retry faxing to see if the
problem is resolved.

● For best results during fax problem solving, make sure the line from the product is connected
directly to the wall phone port. Disconnect all other devices that are connected to the product.

1. Verify that the telephone cord is connected to the correct port on the back of the product.

2. Check the phone line by using the fax test:

a. From the Home screen on the product control panel, touch the Setup  button, and then
touch the Service menu.

b. Select the Fax Service menu.

c. Select the Run Fax Test option. The product prints a fax test report.

The report contains the following possible results:

● Pass: The report contains all of the current fax settings for review.

● Fail: The report indicates the nature of the error and contains suggestions for how to
resolve the issue.

3. Verify that the product firmware is current:

a. Print a configuration page from the control panel Reports menu to obtain the current firmware
date code.

b. Go to www.hp.com.

1. Click the Support & Drivers link.

2. Click the Download drivers and software (and firmware) link option.
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3. In the For product box, enter the product model number, and then click the Go button.

4. Click the link for your operating system.

5. Scroll to the Firmware section of the table.

◦ If the listed version matches the version on the configuration page, you have the
most current version.

◦ If the versions are different, download the firmware upgrade file and upgrade the
firmware on the product following the on-screen instructions.

NOTE: The product must be connected to a computer with internet access to
upgrade firmware.

◦ Resend the fax.

4. Verify that the fax was set up when the product software was installed.

From the computer, in the HP program folder, run the Fax Setup Utility.

5. Verify that the telephone service supports analog fax.

● If using ISDN or digital PBX, contact your service provider for information about configuring
to an analog fax line.

● If using a VoIP service, change the Fax Speed setting to Slow(V.29) from the control panel.
Ask if your service provider supports fax and for the recommended fax modem speed. Some
companies might require an adapter.

● If you are using a DSL service, make sure that a filter is included on the phone-line connection
to the product. Contact the DSL service provider, or purchase a DSL filter if you do not have
one. If a DSL filter is installed, try another filter because filters can be defective.

6. If the error persists, find more detailed problem-solving solutions in the sections that follow this one.

Perform a fax diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
product fax settings.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus:

● Service

● Fax Service

3. Touch the Run Fax Test button to start the test. The product prints a test page that shows test results.
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Fax trace report

A fax T.30 trace report has information that can help resolve fax transmission problems. If you call HP
for help in resolving these problems, print a T.30 trace report before you call.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Print T.30 Trace button, and then touch the Now button.

NOTE: This procedure prints a report for the last fax job, successful or not. To generate a report for
each unsuccessful fax job, select the If Error setting. To generate a report for each fax job, select the At
End of Call setting.

Fax error report printing

Use the following instructions to print fax logs and reports:

Print all fax reports

Use this procedure to print all of the following reports at one time:

● Last Call Report

● Fax Activity Log

● Phone Book Report

● Junk Fax List

● Billing Report (when Billing Codes are turned on)

● Configuration Report

● Usage Page

 

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Touch the Print All fax Reports button.

Print individual fax reports

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.
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3. Touch the Fax Reports button.

4. Touch the name of the report that you want to print.

Set the fax error report

A fax error report is a brief report that indicates the product experienced a fax job error. You can set it
to print after the following events:

● Every fax error (the factory-set default)

● Send fax error

● Receive fax error

● Never

NOTE: With this option, you will have no indication that a fax failed to be transmitted unless
you print a fax activity log.

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Fax Reports button.

4. Touch the Fax Error Report button, and then touch the printing option that you want to use.

Set the fax-error-correction mode

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Change the fax speed

The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide
standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits
per second (bps). The factory-set default for the fax-speed setting is Fast(V.34).
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You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax
overseas, or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Fax Speed button, and then touch the speed setting that you want to use.

Solve problems sending faxes

● An error message displays on the control panel

● The control panel displays a Ready message with no attempt to send the fax

● The control panel displays the message "Storing page 1" and does not progress beyond that
message

● Faxes can be received, but not sent

● Product is password protected

● Unable to use fax functions from the control panel

● Unable to use speed dials

● Unable to use group dials

● Receive a recorded error message from the phone company when trying to send a fax

● Unable to send a fax when a phone is connected to the product

An error message displays on the control panel

The Communication error message appears

● Allow the product to retry sending the fax. Re-sending temporarily reduces the fax speed.

● Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a call. Connect the product phone cord to a jack for another phone line.

● Try a different phone cord.

● From the control panel, change the Fax Speed option to the Medium(V.17) setting or Slow(V.29)
setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.
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d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction option.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: Turning off the Error Correction option can reduce image quality.

● If the error persists, contact HP. See www.hp.com/support/lj500colorMFPM570 or the support
flyer that came in the product box.

No dial tone

● Make sure that the telephone cord is connected to the correct port on the product.

● Make sure that the telephone cord from the product is connected directly to the wall telephone
jack.

● Check for a dial tone on the phone line by using the Start Fax button.

● Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a voice call.

● Disconnect the telephone cord from both the product and the wall and reconnect the cord.

● Make sure that you are using the telephone cord that came with the product.

● Connect the product phone cord to a jack for another phone line.

● Check the phone line by using the Run Fax Test option from the Service menu on the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Run Fax Test item.

The Fax is busy message appears

● Try sending the fax again.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.
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● Check for a dial tone on the phone line by using the Start Fax button.

● Make sure that the phone line is working by disconnecting the product, connecting a telephone to
the phone line, and making a voice call.

● Connect the product phone cord to a jack for another phone line, and try sending the fax again.

● Try a different phone cord.

● Send the fax at a later time.

● If the error persists, contact HP. See www.hp.com/support/lj500colorMFPM570 or the support
flyer that came in the product box.

The No fax answer message appears

● Try to resend the fax.

● Call the recipient to ensure that the fax machine is on and ready.

● Check that you are dialing the correct fax number.

● Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a voice call.

● Connect the product phone cord to a jack for another phone line.

● Try a different phone cord.

● Make sure that the phone cord from the wall telephone jack is connected to the line  port.

● Check the phone line by using the Run Fax Test option from the Service menu on the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Run Fax Test item.

● If the error persists, contact HP. See www.hp.com/support/lj500colorMFPM570 or the support
flyer that came in the product box.

Document feeder paper jam

● Verify that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

● Copy or print the original to letter, A4, or legal size paper, and then resend the fax.
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The Fax storage is full message appears

● Turn the product off then on.

● Print stored faxes that have not been printed.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Receive Options menu.

c. Select the Print Private Faxes item.

d. Provide the password when the product prompts you.

● Delete stored faxes from memory.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

● Divide the large fax job into smaller sections, and then fax them individually.

Scanner error

● Verify that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

● Copy or print the original onto letter, A4, or legal size paper and then resend the fax.

The control panel displays a Ready message with no attempt to send the fax

● Check the fax activity log for errors.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If a phone is connected to the product, make sure that the phone is hung up.

● Disconnect all other lines between the fax and the product.

● Connect the product directly into the wall telephone jack and resend the fax.
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The control panel displays the message "Storing page 1" and does not
progress beyond that message

● Delete stored faxes from memory.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

Faxes can be received, but not sent

Send fax and nothing happens.

1. Check for a dial tone on the phone line by using the Start Fax button.

2. Turn the product off then on.

3. Use the control panel or the HP Fax Setup Wizard to configure the fax time, date, and fax header
information.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Fax Header menu.

e. Enter the correct settings.

4. Verify that any extension phones on the line are hung up.

5. If using a DSL service, make sure that the phone line connection to the product includes a high-
pass filter.

Product is password protected

If a network administrator has set a product password, then you must obtain the password in order to
use the product fax features.

Unable to use fax functions from the control panel

● The product might be password protected. Use the HP Embedded Web Server, HP Toolbox
software, or the control panel to set a password.

● If you do not know the password for the product, contact your system administrator.

● Verify with the system administrator that the fax functionality has not been disabled.
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Unable to use speed dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

Unable to use group dials

● Make sure that the fax number is valid.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

● Set up all entries in the group with speed dial entries.

a. Open an unused speed dial entry.

b. Enter the fax number for the speed dial.

c. Touch the OK button to save the speed dial.

Receive a recorded error message from the phone company when trying to
send a fax

● Make sure you dial the fax number correctly, and make sure that the phone service is not blocked.
For example, some phone services might prevent long distance calling.

● If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.
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d. Open the Dial Prefix menu.

e. Select the On setting.

NOTE: To send a fax without a prefix, when the Dial Prefix option is turned on, send the fax
manually.

● Send a fax to an international number

a. If a prefix is required, manually dial the telephone number with the prefix.

b. Enter the country/region code before dialing the phone number.

c. Wait for pauses as you hear the tones on the phone.

d. Send the fax manually from the control panel.

Unable to send a fax when a phone is connected to the product

● Make sure that the telephone is hung up.

● Make sure that the telephone is not being used for a voice call when faxing.

● Disconnect the phone from the line, and then try sending the fax.

Solve problems receiving faxes

● The fax does not respond

● An error message displays on the control panel

● A fax is received but does not print

● Sender receives a busy signal

● No dial tone

● Cannot send or receive a fax on a PBX line

The fax does not respond

The fax has a dedicated phone line

● Set the Answer Mode option to the Automatic setting from the control panel.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Automatic setting.
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An answering machine is connected to the product

● Set the Answer Mode option to the TAM setting and connect the answering machine to the
“telephone” port.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the TAM setting.

If the TAM setting is unavailable, set the Answer Mode option to the Automatic setting.

● Set the Rings to Answer setting to at least one ring more than the number of rings for which the
answering machine is set.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Rings to Answer menu.

e. Select the correct setting.

● Connect the answering machine to the “telephone” port.

● If the product has a telephone handset connected, set the Answer Mode option to the Fax/Tel
setting to route calls to the correct device. When detecting a voice call, the product generates a
ring tone that alerts you to pick up the telephone handset.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Fax/Tel setting.

The Answer Mode setting is set to the Manual setting

● Touch the Start Fax button on the product control panel.
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Voice mail is available on the fax line

● Add a distinctive ring service to your telephone line and change the Distinctive Ring setting on the
product to match the ring pattern supplied by the telephone company. Contact your telephone
company for information.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Distinctive Ring menu.

e. Select the correct setting.

● Buy a dedicated line for faxing.

● Set the Answer Mode option to the Manual setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Manual setting.

NOTE: You must be present to receive faxes.

The product is connected to a DSL phone service

● Check the installation and features. A DSL modem requires a high-pass filter on the phone line
connection to the product. Contact your DSL service provider for a filter or buy a filter.

● Verify that the filter is connected.

● Replace the existing filter to make sure that it is not defective.

The product uses a fax over IP or VoIP phone service

● Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Contact your service provider to make sure that fax is supported and for a recommended fax
speed settings. Some companies might require an adapter.
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An error message displays on the control panel

The No fax detected. message displays

NOTE: This error does not always refer to a missed fax. If a voice call is made to a fax number by
mistake and the caller hangs up, the No fax detected. message displays on the control panel.

● Ask the sender to resend the fax.

● Make sure that the telephone cord from the product is connected to the wall telephone jack.

● Try a different phone cord.

● Connect the product phone cord to a jack for another phone line.

● Make sure the telephone line and phone wall jack are active by connecting a telephone and
checking for a dial tone.

● Make sure that the telephone cord is connected to the “line” port on the product.

● Check the phone line by running a fax test from the control panel.

● If the error persists, contact HP. See www.hp.com/support/lj500colorMFPM570 or the support
flyer that came in the product box.

The Communication error message appears

● Ask the sender to send the fax again or send at a later time when line conditions have improved.

● Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a call. Plug the product phone cord into a jack for another phone line.

● Try a different phone cord.

● Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Turn off the Error Correction feature to prevent automatic error correction.

NOTE: Turning off the Error Correction feature can reduce image quality.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Service menu.

c. Open the Fax Service menu.
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d. Open the Error Correction menu.

e. Select the Off setting.

● Print the Fax Activity Log report from the control panel to determine if the error occurs with a
specific fax number.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

● If the error persists, contact HP. See www.hp.com/support/lj500colorMFPM570 or the support
flyer that came in the product box.

The Fax storage is full message appears

● Turn the product off then on.

● Print all of the faxes, and then have the sender resend the fax.

● Ask the sender to divide a large fax job into smaller sections, and then fax them individually.

● Make sure that the resolution of the sending fax machine is not set to the Photo setting or the
Superfine setting.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

● Cancel all fax jobs or clear the faxes from memory.

The Fax is busy message appears

● The product cannot receive a fax while attempting to send one. Cancel the fax send and try
sending at a later time.

● Allow the product to try sending the fax again.
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A fax is received but does not print

The Private Receive feature is on

● When the Private Receive feature is activated, received faxes are stored in memory. A password is
required to print the stored faxes.

● Enter the password to print the fax. If you do not know the password, contact the product
administrator.

NOTE: Memory errors might occur if the faxes are not printed. The product will not answer if the
memory is full.

Sender receives a busy signal

A handset is connected to the product

● Make sure the phone is hung up.

● Change the Answer Mode option to match the product setup.

a. From the Home screen on the product control panel, touch the Setup  button.

b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the setting that matches the product setup.

Set the Answer Mode option to the Fax/Tel setting to automatically receive faxes. The Fax/
Tel setting automatically detects whether the incoming transmission is a fax or a voice call
and routes the call to the appropriate device.

A phone line splitter is being used

● If you are using a phone line splitter, remove the splitter and set up the phone as a downstream
phone.

● Make sure the phone is hung up.

● Make sure the phone is not being used for a voice call when faxing.

No dial tone

● If using a phone line splitter, remove the phone line splitter and set up the phone as a downstream
phone.

Cannot send or receive a fax on a PBX line

● If you are using a PBX phone line, contact your PBX administrator to configure an analog fax line
for your product.
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Solve general fax problems

● Faxes are sending slowly

● Fax quality is poor

● Fax cuts off or prints on two pages

Faxes are sending slowly

The product is experiencing poor phone line quality.

● Retry sending the fax when the line conditions have improved.

● Check with the phone service provider that the line supports fax.

● Turn off the Error Correction setting.

a. Open the Setup Menu menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

NOTE: This can reduce image quality.

● Use white paper for the original. Do not use colors such as gray, yellow, or pink.

● Increase the Fax Speed setting.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

● Divide large fax jobs into smaller sections, and then fax them individually.

● Change the fax settings on the control panel to a lower resolution.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.
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Fax quality is poor

Fax is blurry or light.

● Increase fax resolution when sending faxes. Resolution does not affect received faxes.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

NOTE: Increasing resolution slows transmission speed.

● Turn on the Error Correction setting from the control panel.

a. Open the Setup Menu menu.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the On setting.

● Check the toner cartridges and replace if necessary.

● Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.

Fax cuts off or prints on two pages

● Set the Default Paper Size setting. Faxes print on a single size of paper based on the Default
Paper Size settings.

a. Open the Setup Menu menu.

b. Open the System Setup menu.

c. Open the Paper Setup menu.

d. Open the Default Paper Size menu.

e. Select the correct setting.

● Set the paper type and size for the tray used for faxes.

● Turn on the Fit to Page setting to print longer length faxes on letter or A4 size paper.

a. Open the Setup Menu menu.

b. Open the Fax Setup menu.
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c. Open the Advanced Setup menu.

d. Open the Fit to Page menu.

e. Select the On setting.

NOTE: If the Fit to Page setting is off and the Default Paper Size setting is set to letter, a legal size
original prints on two pages.
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Solve USB connection problems
If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft
operating systems and not of the HP print drivers. For more information, go to Microsoft at
www.microsoft.com.

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the
network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems
● Wireless connectivity checklist

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

● Perform a wireless network diagnostic test

● Reduce interference on a wireless network

Wireless connectivity checklist

● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure that
the wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the
SSID. If you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network.
If the network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless
access point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the product
must be within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the
access point and the product. Make sure poles, walls, or support columns containing metal or
concrete do not separate the product and wireless access point.

● Verify that the product is located away from electronic devices that might interfere with the
wireless signal. Many devices can interfere with the wireless signal including motors, cordless
phones, security system cameras, other wireless networks, and some Bluetooth devices.

● Verify that the print driver is installed on the computer.

● Verify that you have selected the correct printer port.
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● Verify that the computer and product connect to the same wireless network.

● For Mac OS X, verify that the wireless router supports Bonjour.

The product does not print after the wireless configuration
completes

1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.

5. Verify that you can open the product HP Embedded Web Server from a computer on the network.

The product does not print, and the computer has a third-party
firewall installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless
router or product

1. Make sure that the router or product connects to the same network that your computer connects to.

2. Print a configuration page.

3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for the computer.

4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the
signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.
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4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a
VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the router IP address.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.
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Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
wireless network settings.

1. From the Home screen on the product control panel, touch the Setup  button.

2. Open the following menus

● System Setup

● Self Diagnostics

3. Touch the Run Network Test button to start the test. The product prints a test page that shows test
results.

Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt
radio signals.

● Keep the wireless devices away from large masonry structures and other building structures. These
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Solve product software problems with Windows
● A print driver for the product is not visible in the Printer folder

● An error message was displayed during the software installation

● The product is in Ready mode, but nothing prints

A print driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try connecting the USB cable to a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use
one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista

a. Click Start.

b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Right-click the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.

ENWW Solve product software problems with Windows 235



f. Verify the IP address, and then click OK or Cancel.

g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.

Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Solve product software problems with Mac OS X
● The print driver is not listed in the Print & Fax or Print & Scan list

● The product name does not appear in the product list in the Print & Fax or Print & Scan list

● The print driver does not automatically set up the selected product in the Print & Fax or Print &
Scan list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan
list after the driver is selected.

● You are using a generic print driver when using a USB connection

The print driver is not listed in the Print & Fax or Print & Scan list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print &
Fax or Print & Scan list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

3. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

4. Replace the USB or network cable with a high-quality cable.

The print driver does not automatically set up the selected product
in the Print & Fax or Print & Scan list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

5. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

When connected with a USB cable, the product does not appear in
the Print & Fax or Print & Scan list after the driver is selected.

Software troubleshooting

1. Make sure that your Mac operating system is Mac OS X 10.6 or later.

2. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate Hi-Speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and then connect the cable directly to the USB port on the
computer.

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic print driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic print
driver instead of the driver for this product.

1. Delete the generic print driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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Remove software (Windows)

Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the on-screen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the on-screen instructions to remove the software.
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Remove software (Mac OS X)
You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Open Hewlett Packard.

4. Open HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.
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Solve scan to email problems
If scan to email problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Email feature is enabled. If it has been disabled, enable the feature through
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a computer or to a network.

Cannot connect to the email server

● Make sure the SMTP server name is correct. Check this setting with your system administrator or
Internet Service Provider.

● If the product cannot establish a secure connection to the SMTP server, try without the secure
connection or try a different server or port. Check this setting with your system administrator or
Internet Service Provider.

● If the SMTP server requires authentication, make sure a valid user name and password are used.

● If the SMTP server uses an authentication method that is not supported, try a different server.
Check this setting with your system administrator or Internet Service Provider.

The email failed

● Verify that email addresses entered are correct.

● If the size of the email was too large, send fewer pages or reduce the scan resolution.

Unable to scan

● If you are prompted for a PIN, enter the correct PIN for the outgoing profile.

● Make sure at least one email address is selected in the To field.
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Solve scan to network folder problems
If scan to network folder problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Network Folder feature is enabled. If it has been disabled, enable the
feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a network.

● Use the test option on the Scan tab of the HP Device Toolbox (Windows) or the HP Utility (Mac OS
X) to verify the Scan to Network Folder feature is set up correctly.

The scan failed

● Make sure the network path is in the correct format (//host/share/path) and the folder exists.

● Make sure the network directory is readable and writeable.

● If you are using the default file names for scanned documents, make sure there are no conflicting
file names. Remove some of the previously scanned documents.

● Use the IP address instead of the host name. Make sure the product and host are connected to the
same network.

● If the network folder is password protected, make sure to enter the correct user name and
password.

● If a Disk full message displays, remove some files from the network folder.

● Turn the product off, and then on. Scan again.
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A
accessories

ordering 32
AirPrint 89
answer mode, setting 131
answering machines, connecting

fax settings 132
anticounterfeit supplies 34
applications

downloading 152
Apps menu 152
archival-quality printing 83
autoreduction settings, fax 134

B
billing codes, fax

using 129
bins, output

locating 4
blocking faxes 132
booklets

creating (Windows) 73
printing (Mac) 78

busy signals, redialing options
127

C
cable, USB

part number 38
canceling

faxes 137
print job (Mac) 81
print job (Windows) 79

capacity
Tray 1 19
Tray 2 25
Tray 3 28

cartridges
non-HP 33, 40

order numbers 40
recycling 40
replacing 41
storage 40
supplies status page 11

checklist
fax troubleshooting 209
for solving problems 166
wireless connectivity 231

cleaning
glass 194, 198, 201
paper path 188

collating copies 98
color

Edge Control 86
match 86
Neutral Grays 86
printed vs. monitor 86

color alignment, calibrating 187
color options

changing, Windows 191
HP EasyColor (Windows) 84
setting (Mac) 86

color or black and white
copying 102

color theme
changing, Windows 85, 191

color usage log 11
configuration page 11
contrast settings

copy 104
fax 128

control panel
buttons and lights 8
help 10, 170
Home screen 9
locating 4
menu map, printing 11
Reports menu 11

copying
adjusting image quality 105
collation 98
color or black and white 102
contrast, adjusting 104
draft mode 106
enlarging 101
light/dark settings 104
multiple copies 95
multiple-page originals 96
paper size and type 107
quality, adjusting 103
reducing 101
restore default settings 93
set new default settings 92
single copies 94
two-sided documents 99, 100

counterfeit supplies 34
cover pages

printing on different paper
(Windows) 68

covers, locating 4
custom-size copies 101
customer self-repair

part numbers 37

D
darkness, contrast settings

copy 104
fax 128

default copy settings
changing 92
restoring to factory settings 93

default gateway, setting 153
defaults, restoring 169
delaying fax sending 144
deleting faxes from memory 138
dial tone detection settings 127
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dialing
from a telephone 144
pauses, inserting 126
prefixes, inserting 126
redialing automatically,

settings 127
tone or pulse settings 127

distinctive-ring settings 133
document feeder 99

copying two-sided documents
99

jams 174
paper-feeding problems 172

dots per inch (dpi)
fax 128

double-sided copying 99, 100
double-sided printing

Mac 76
Windows 60

dpi (dots per inch)
fax 128

draft mode, copying 106
drivers

changing paper sizes 79
changing settings (Mac) 52
changing settings (Windows)

50
paper types 17
presets (Mac) 75
selecting 192
settings (Mac) 75
universal 48
usage page 11

DSL
faxing 138

duplex 99
duplex printing

Mac 76
duplex printing (double-sided)

settings (Windows) 58
Windows 60

duplex settings, changing 155
duplexing

manually (Mac) 76
manually (Windows) 60

E
EconoMode setting 160, 190
economy settings 160
Edge Control 86

electronic faxes
sending 142

Embedded Web Server 168
changing network settings 153
changing password 162
changing product name 154
opening 153, 154, 162

enlarging documents
copying 101

error messages, fax 213, 219
error report, fax

printing 212
error-correction setting, fax 212
errors

software 235
extension phones

receiving faxes from 118
sending faxes from 144

F
factory-set defaults, restoring 169
fax

answer mode 131
autoreduction 134
billing codes 129
blocking 132
canceling 137
confirming number 144
contrast setting 128
delaying sending 144
deleting from memory 138
detect-dial-tone settings 127
dial prefixes 126
dialing, tone or pulse 127
error report, printing 212
error-correction 212
extension phone receiving

118
forwarding 131
pauses, inserting 126
polling 136
printing 146
printing private faxes 148
private receive 135
receiving when you hear fax

tones 148
redial settings 127
reports, printing all 211
reprinting faxes 134
reprinting from memory 147

resolution 128
ring patterns 133
rings-to-answer 132
security, private receive 135
sending from a telephone 144
sending from software 142
solve general problems 225
solving problems 168
speed dials 142
stamp-received 135
unable to receive 219
unable to send 213
using DSL, PBX, or ISDN 138
using VoIP 139
V.34 setting 212
volume settings 135

fax date, setup
use control panel 120
use HP Fax Setup Wizard 120

fax header, setup
use control panel 120
use HP Fax Setup Wizard 120

fax time, setup
use control panel 120
use HP Fax Setup Wizard 120

fax troubleshooting
checklist 209

faxing
from a computer (Mac) 142
from a computer (Windows)

142
first page

printing on different paper
(Windows) 68

Fit to Page setting, fax 134
fonts

lists, printing 11
forwarding faxes 131
fraud Web site 34
fuser

jams 180

G
gateway, setting default 153
glass, cleaning 194, 198, 201
group-dial entries

creating 124
deleting 125
editing 124
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H
help, control panel 10, 170
Home screen, control panel 9
HP Device Toolbox, using 156
HP Easy Color

disabling 84
using 84

HP Embedded Web Server 168
changing network settings 153
changing password 162
changing product name 154
opening 153, 154, 162

HP ePrint, using 88
HP fraud Web site 34
HP Reconfiguration Utility

network installation 150
HP Scan software (Mac) 111
HP Scan software (Windows) 110
HP Universal Print Driver 48
HP Utility 158
HP Utility for Mac

Bonjour 158
features 158

HP Utility, Mac 158
HP Web Jetadmin 159
HP Web Services

applications 152
enabling 152

HP Web Services, enabling 88

I
identification cards

copying 97
interface ports

locating 5, 6
IPv4 address 153
ISDN

faxing 138

J
jams

causes of 172
document feeder, clearing

174
fuser 180
locations 173
lower right door 185
output bin 176
right door 180
tracking number of 11

Tray 1 177
Tray 2 179
Tray 3 184, 185

Jetadmin, HP Web 159

L
labels

printing (Windows) 65
landscape orientation

changing (Mac) 77
selecting, Windows 63

last page
printing on different paper

(Windows) 68
lightness

copy contrast 104
fax contrast 128

link speed settings 155
loading

toner cartridges 39
Tray 1 21
Tray 2 26
Tray 3 29

lock
product 162

logs, fax
error 212
printing all 211

lower right door
jams 185

M
Mac

driver settings 52, 75
problems, troubleshooting 237
scanning from TWAIN-

compliant software 116
Macintosh

HP Utility 158
maintenance kits

part numbers 37
managing network 153
manual duplex

Mac 76
Windows 60

media
supported sizes 14

memory
deleting faxes 138

included 2
reprinting faxes 147

menus, control panel
map, printing 11

Microsoft Word, faxing from 143
multiple copies 95
multiple pages per sheet

printing (Mac) 76
printing (Windows) 61

multiple-page originals
copying 96

N
network

password, changing 162
password, setting 162
product name, changing 154
settings, changing 153
settings, viewing 153

networks
configuration page 11
default gateway 153
HP Web Jetadmin 159
installing the product 150
IPv4 address 153
models supporting 2
settings report 11
subnet mask 153

Neutral Grays 86
non-HP supplies 33, 40
number of copies, changing 95

O
OCR software 116
on/off button, locating 4
online help, control panel 10,

170
optical character recognition

software 116
ordering

supplies and accessories 32
orientation

changing (Mac) 77
selecting, Windows 63
Tray 3 28

output bin
jams 176
locating 4
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outside lines
dial prefixes 126
pauses, inserting 126

P
page count 11
page orientation

changing (Mac) 77
page sizes

scaling documents to fit (Mac)
77

scaling documents to fit
(Windows) 71

pages per minute 2
pages per sheet

selecting (Mac) 76
selecting (Windows) 61

paper
covers, using different paper

68
fax autoreduction settings 134
first and last pages, using

different paper 68
jams 172
ordering 32
selecting 190
supported sizes 14
supported types 17

paper jams. See jams
paper pickup problems

solving 171
paper size

changing 79
paper sizes

copy settings 107
selecting (Mac) 81
selecting custom sizes (Mac)

81
selecting custom sizes

(Windows) 80
paper type

selecting (Windows) 65
paper types

copy settings 107
selecting (Mac) 77

paper, covers
printing (Mac) 77

part numbers
customer self-repair 37

maintenance kits 37
supplies 37

pauses, inserting 126
PBX

faxing 138
PCL drivers

universal 48
PCL font list 11
phone book, fax

adding entries 142
deleting all entries 121

phones
receiving faxes from 118, 148

phones, downstream
sending faxes from 144

polling faxes 136
portrait orientation

changing (Mac) 77
selecting, Windows 63

ports
locating 6

power connection
locating 5, 6

power switch, locating 4
power-down delay

setting 160
prefixes, dial 126
presets (Mac) 75
print drivers

selecting 192
supported 48

print drivers (Mac)
changing settings 52
settings 75

print drivers (Windows)
changing settings 50

print job
canceling (Mac) 81
canceling (Windows) 79

print on both sides
Mac 76
manually, Windows 60
Windows 60

print quality
improving 186

print quality page
interpreting 188
printing 188

printing
from USB flash drives 90

product reports 11
settings (Mac) 75

printing on both sides
settings (Windows) 58

private receive 135
problem-solving

no response 205
slow response 206

protocol settings, fax 212
PS font list 11
pulse-dialing 127

R
Readiris OCR software 116
receiving faxes

answer mode, setting 131
autoreduction settings 134
blocking 132
error report, printing 212
from extension phone 118
polling 136
reprinting 147
reprinting faxes 134
ring patterns, settings 133
rings-to-answer settings 132
stamp-received setting 135
when you hear fax tones 148

recycling supplies 40
redialing

automatically, settings 127
reducing documents

copying 101
replacing printing cartridges 41
reports

color usage log 11
configuration report 11
Demo Page 11
diagnostics page 11
menu structure 11
network summary 11
PCL font list 11
PCL6 font list 11
print quality page 11
PS font list 11
service page 11
supplies status 11
usage page 11

Reports menu 11
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reports, fax
error 212
printing all 211

reprinting faxes 134, 147
resize documents

copying 101
Mac 77
Windows 71

resolution
fax 128

restoring factory-set defaults 169
right door

jams 180
ring patterns 133
ring tones

distinctive 133
rings-to-answer setting 132

S
scale documents

Mac 77
Windows 71

scaling documents
copying 101

scanner
glass cleaning 194, 198, 201

scanning
from HP Scan software (Mac)

111
from HP Scan software

(Windows) 110
OCR software 116
to email, setup 113
to network folder, setup 113
TWAIN-compliant software

116
WIA-compliant software 116

sending faxes
billing codes 129
canceling 137
confirmation 144
delaying 144
error report, printing 212
forwarding 131
from downstream telephone

144
from software 142

service page 11
settings

driver presets (Mac) 75

drivers 50
drivers (Mac) 52
factory-set defaults, restoring

169
network report 11

setup
scan to email and network

folder 113
shortcuts (Windows)

creating 56
using 54

size, copy
reducing or enlarging 101

sizes, media
Fit to Page setting, faxing 134

sleep delay
disabling 160
enabling 160

small documents
copying 97

software
HP Utility 158
problems 235
Readiris OCR 116
scanning from TWAIN or

WIA 116
sending faxes 142
uninstalling for Mac 240
uninstalling for Windows 239

solve
fax problems 213

solve problems
fax 225

solving
walk-up USB printing

problems 207
special paper

printing (Windows) 65
special paper for covers

printing (Mac) 77
speed dials

programming 142
speed-dial entries

creating 122
deleting 123
editing 122

status
Home screen, control panel 9
HP Utility, Mac 158
supplies, printing report 11

storing
toner cartridges 40

subnet mask 153
supplies

counterfeit 34
low threshold settings 35
non-HP 33, 40
ordering 32
part numbers 37
recycling 40
replacing toner cartridges 41
status, viewing with HP Utility

for Mac 158
using when low 35

supplies status page 11
supported media 14

T
TCP/IP

manually configuring IPv4
parameters 153

telephones
receiving faxes from 118, 148

telephones, downstream
sending faxes from 144

tone-dialing 127
toner cartridge

checking for damage 189
low threshold settings 35
using when low 35

toner cartridges
loading 39
non-HP 33, 40
order numbers 40
recycling 40
replacing 41
storage 40
supplies status page 11

toner collection unit
replacing 44

transparencies
printing (Windows) 65

trapping 86
Tray 1

capacity 19
jams 177
loading 21
orientation 19

Tray 2
capacity 25
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jams 179
loading 26
orientation 25

Tray 3
capacity 28
jams 184, 185
loading 29
orientation 28

trays
included 2
locating 4

troubleshooting
checklist 166
fax error-correction setting

212
faxes 209
jams 172
Mac problems 237
network problems 229
paper feed problems 171
receive fax 219
send fax 213
USB connection 228
walk-up USB printing

problems 207
Windows problems 235
wired network 229
wireless network 231

TWAIN-compliant software,
scanning from 116

two-sided copying 99, 100
two-sided printing

settings (Windows) 58

U
unblocking fax numbers 132
uninstalling Mac software 240
uninstalling Windows software

239
universal print driver 48
usage page 11
USB connection

troubleshooting 228
USB flash drives

printing from 90

V
V.34 setting 212
VoIP

faxing 139

volume, adjusting 135

W
walk-up USB printing 90
watermarks

printing (Mac) 82
printing (Windows) 80

Web Services
applications 152
enabling 152

Web sites
fraud reports 34
HP Web Jetadmin,

downloading 159
universal print driver 48

WIA-compliant software, scanning
from 116

Windows
driver settings 50
faxing from 142
scanning from TWAIN or WIA

software 116
universal print driver 48

Windows print drivers
supported 48

wireless network
troubleshooting 231

wireless network interference 234
wireless printing

solving problems 166
Word, faxing from 143
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